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Chapter 1. Introduction

The IBM® System Storage™ DS3000 Storage Manager Version 10 (referred to
throughout this document as Storage Manager software) is host software that you
can use to manage your storage subsystems.

This document provides information about how to prepare, install, configure, and
work with the Storage Manager software in each of the following AMD or Intel®
processor-based operating systems:

+ Microsoft® Windows® Server 2003 with Service Pack 2

* Microsoft Windows Server 2008

* Novell NetWare 6.5 (DS3200 and DS3400 storage subsystems only)
+ Red Hat® Enterprise Linux® 5 (RHEL 5)

* Red Hat Enterprise Linux Advanced Server 4.0 (RHEL AS 4)

» SUSE Linux Enterprise Server 9 (SLES 9)

* SUSE Linux Enterprise Server 10 (SLES 10) and SUSE Linux Enterprise Server
10 Service Pack 1

* VMware ESX Server 2.5.4, VMware ESX Server 3.0.1, VMware ESX Server
3.0.2, VMware ESX Server 3.5, VMware ESX Server 3.5.1, and VMware ESX
Server 3.5.2

For an interoperability matrix that lists the operating systems that are supported by
the Storage Manager software, see the following Web sites:

+ For the DS3200: |http://www.ibm.com/systems/storage/disk/ds3000/ds3200/

+ For the DS3300: |http://www.ibm.com/systems/storage/disk/ds3000/ds3300/

+ For the DS3400: |http://www.ibm.com/systems/storage/disk/ds3000/ds3400/

Obtaining the documentation from the IBM Support Web site

If firmware and documentation updates are available, you can download them from
the IBM support Web site. The Storage Manager software might have features that
are not described in the documentation that comes with the unit, and the
documentation might be updated occasionally to include information about those
features, or technical updates might be available to provide additional information
that is not included in the storage subsystem documentation. To check for updates,
complete the following steps.

Note: Changes are made periodically to the IBM Web site. Procedures for locating
firmware and documentation might vary slightly from what is described in this
document.

Go to jttp://www.ibm.com/servers/storage/support/

Under Select your product, in the Product Family field, click Disk systems.
In the Product field, click DS3200, DS3300, or DS3400, as applicable.

Click Go.

Make the following selections:

* For firmware updates and readme files, under Support & downloads, click
Download.

* For documentation updates, under Support & downloads, click
Documentation.

o~ oobd -
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Notices in this document

The following notices are used in this document:
* Note: These notices provide important tips, guidance, or advice.

» Important: These notices provide information or advice that might help you avoid
inconvenient or problem situations.

« Attention: These notices indicate potential damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage might occur.

Storage Manager software online help and diagnostics

When you are finished with the installation process, see the following online help
systems:

» Enterprise Management window help
Use this online help system to learn more about working with the entire
management domain.

* Subsystem Management window help
Use this online help system to learn more about managing individual storage
subsystems.

You can access these help systems from within the Storage Manager Client. From
either an Enterprise Management or Subsystem Management window, click Help or
press F1.

Fibre Channel and iSCSI host bus adapter diagnostics

Before you use the storage subsystem, you can use a diagnostic application to
make sure that the host connections are working correctly.

If you are managing Fibre Channel host bus adapters, after you install the Storage
Manager software, install the QLogic SANsurfer Fibre Channel Management tool or
the Emulex HBAnywhere utility. If you are managing iSCSI host bus adapters,
install the QLogic SANsurfer iSCSI HBA Manager tool.

The QLogic SANsurfer program files and the Emulex HBAnywhere utility program
files are available at |ttp://www.ibm.com/servers/storage/support/diski

Premium features

Premium features provide enhanced functionality that enables you to perform tasks
that might be limited or unavailable with your base storage subsystem model. For

more information, see |Chapter 10, “Enabling and using premium features,” on page|
-101.

You can purchase the following premium features for a DS3000 storage subsystem:
+ DS3000 FlashCopy Expansion License

» DS3000 Volume Copy License

» DS3000 FlashCopy Volume Copy License

« DS3000 Partition Expansion License

2 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware
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FlashCopy
The FlashCopy feature supports the creation and management of
FlashCopy logical drives. A FlashCopy logical drive is a logical point-in-time
image of another logical drive, called a base logical drive, that is in the
storage subsystem. A FlashCopy image is the logical equivalent of a
complete physical copy, but you create it much more quickly and it requires
less disk space.

Because a FlashCopy image is a host-addressable logical drive, you can
perform backups by using the FlashCopy image while the base logical drive
remains online and user-accessible. You can also write to the FlashCopy
logical drive to perform application testing or scenario development and
analysis. The maximum number of FlashCopy logical drives that are
allowed is one-half of the total number of logical drives that are supported
by your controller model.

VolumeCopy
The VolumeCopy feature is a firmware-based mechanism for replicating
logical drive data within a storage array. This feature is designed as a
system management tool for tasks such as relocating data to other drives
for hardware upgrades or performance management, data backup, or
restoring FlashCopy logical drive data.

You submit VolumeCopy requests by specifying two compatible drives. One
drive is designated as the Source and the other as the Target. The
VolumeCopy request is persistent so that any relevant result of the copy
process can be communicated to you.

Note: The terms VolumeCopy and Logical Drive Copy are used
interchangeably throughout this document, the Storage Manager
Client program interface, and the online help.

Partition Expansion

You can use the Partition Expansion feature to present all of the defined
logical drives in a storage subsystem to a SAN, through several different
partitions. You can do this by mapping each logical drive to a LUN (0 - 31)
in each of the defined partitions. A logical drive can be mapped to only one
partition at a time. In a storage partition, the mapped logical drives are
accessible only to the host server or servers whose host bus adapter host
ports are defined in that storage partition. This feature enables the DS3000
storage subsystem to act as a multiple virtual storage subsystem to the
host server.

Partition Expansion also enables multiple hosts that use different operating

systems, with their own unique disk storage subsystem settings, to connect
to the same DS3000 storage subsystem at the same time. This is known as
a heterogeneous host environment.

Chapter 1. Introduction 3



Terms to know

For more information about terminology, see the online help in the Storage Manager
Enterprise Management window or the Storage Subsystem Management window.

It is important to understand the distinction between the following two terms when
you read this document.

Management station
A management station is a system that is used to manage a DS3000
storage subsystem. You can connect a management station to the storage
subsystem by using either of the following methods:

» Through a TCP/IP Ethernet connection to the controllers in the storage
subsystem (out-of-band method)

» Through a TCP/IP connection to the host-agent software that is installed
on a host server, which in turn is directly attached to the storage
subsystem through the input/output (I/O) path (in-band method)

For more information, see [‘Storage subsystem management methods” on|

Host server
A host server is a server that is connected directly to a DS3000 storage
subsystem through the 1/O path. This server is used to perform the following
tasks:
» Serve data (typically in the form of files) from the storage subsystem

* Function as a connection point to the storage subsystem for a
remote-management station

Notes:

1. The terms host and host server are used interchangeably throughout
this document.

2. A host server can also function as a management station.

4 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware



Hardware requirements

lists the hardware requirements for installing the Storage Manager 2
software.

Table 1. Hardware requirements for the Storage Manager 2 software

Hardware component Requirements
Management station (for The management station computer requires the following
client software) hardware:

+ Intel Pentium® or Pentium-equivalent microprocessor (450
MHz or faster)

+ CD drive
» Mouse or similar pointing device

» System memory for Windows Server 2003, Linux, and
NetWare: A minimum of 256 MB (512 MB preferred)

» Ethernet network interface adapter

* AGP or PCI video adapter (AGP preferred); ISA adapters
are not supported

» Monitor setting of 1024 x 768 pixels with 64 000 colors. The
minimum display setting that is allowed is 800 x 600 pixels
with 256 colors.

* Hardware-based video acceleration. For the best
performance with the Storage Manager software, do not
use desktop computers that use system memory for video
memory.

Important: Some servers are not designed to run
graphic-intensive software. If your server has difficulty
displaying the Storage Manager user interface, you might
have to upgrade the server video adapter.

For more information about host adapters, fabric switches, and managed hubs, see
the following ServerProven® and interoperability Web sites:

http://www.ibm.com/servers/eserver/serverproven/compat/us/|

Ihttp://www.ibm.com/systems/storage/disk/ds3000/ds3200/|

Ihttp://www.ibm.com/systems/storage/disk/ds3000/ds3300/|

Ihttp://www.ibm.com/systems/storage/disk/ds3000/ds3400/|

Microsoft Windows software requirements

The Storage Manager software requirements and the Microsoft Windows operating
system requirements are described in the following sections.

Storage Manager software requirements

[Table 2 on page 6|lists the disk space and administrator privileges that are required
to install the Storage Manager software in a Windows environment.

Note: The disk space that is listed in[Table 2 on page 6| is for the packages after
the installation. During the installation of each software package, you might
need up to 150 MB of free disk space.
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Table 2. Installation requirements for Windows Server 2003 and Windows Server 2008 by
software package

Disk space requirement for Administrator privilege for
Windows Server 2003 and Windows Server 2003 and
Package Windows Server 2008 Windows Server 2008
SMclient 130 MB Administrator privilege is not required.
MPIO 2 VB Administrator privilege is required.
SMagent 1 MB Administrator privilege is required.
50 MB (if SMclient is not installed)
SMutil 2 MB Administrator privilege is required.

Windows operating system requirements

Each management station, host server, or cluster node requires one of the following
operating systems.

Important: For the latest supported operating system and host software versions,
see the Storage Manager readme files and see ttp://www.ibm.com/|
lservers/eserver/serverproven/compat/us/|

Management station

* Microsoft Windows Server 2003 or Windows Server 2008, Web Edition

* Microsoft Windows Server 2003 or Windows Server 2008, Standard Edition
* Microsoft Windows Server 2003 or Windows Server 2008, Enterprise Edition
e Microsoft Windows XP, Professional Edition

* Microsoft Windows Vista, Business or Enterprise Edition

Host server

* Microsoft Windows Server 2003 or Windows Server 2008, Web Edition

* Microsoft Windows Server 2003 or Windows Server 2008, Standard Edition
* Microsoft Windows Server 2003 or Windows Server 2008, Enterprise Edition

Cluster node
* Microsoft Windows Server 2003 or Windows Server 2008, Enterprise Edition

Note: For Windows Server 2003 editions, Service Pack 2 or later must be installed.

Linux software requirements

The Storage Manager software requirements and the Linux operating system
requirements are described in the following sections.

Storage Manager software requirements

lists the disk space that is required for installing the Storage Manager
software in a Linux environment.

Table 3. Installation requirements for Linux by software package

Package Disk space requirement
Storage Manager Client (SMclient) 165 MB in /opt, 2 MB in /tmp, 1 MB in /var
Linux MPP 2 MB
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Table 3. Installation requirements for Linux by software package (continued)

Package Disk space requirement
Storage Manager Agent (SMagent) 2 MB in /opt
Storage Manager Utility (SMutil) 7 MB in /opt

Linux operating system requirements
The following kernel levels are required for Linux operating systems:
» 2.6 kernel (RHEL 4, SLES 9, and SLES 10) for RDAC Revision B
+ 2.6 kernel (RHEL 5 and SLES 10 SP1) for RDAC Revision C

For the latest supported Linux operating systems, details about device driver levels,
and instructions for multipath configurations for Linux support, see the Storage
Manager software readme files.

NetWare software requirements

The Storage Manager software requirements and the Novell NetWare operating
system requirements are described in the following sections.

Note: As of the date of this document, the DS3300 storage subsystem does not
support the Novell NetWare operating system.

Storage Manager software requirements

The Storage Manager software, which is required to manage a DS3000 storage
subsystem, is not available for the NetWare operating system environment.

To manage a DS3000 storage subsystem that is connected to a NetWare host
server, you must install the Windows or Linux version of the Storage Manager
SMclient program on a management station and make an out-of-band management
connection to the DS3000 storage subsystem.

Important: For details about specific device-driver levels and instructions for
multipath configuration for NetWare support, see the readme file.

lists the disk space that is required for installing the Storage Manager
software in a NetWare host environment.

Table 4. Installation requirements for NetWare by software package

Package Disk space requirement
LSIMPE.cdm driver 2 MB
Host bus adapter device driver 2 MB

NetWare operating system requirements

Each management station, host server, or cluster node requires one of the following
operating systems.

Important: For the latest supported operating system and host software versions,
see the Storage Manager readme files, and see |nttp://www.ibm.com/|
[servers/eserver/serverproven/compat/us/|
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Management station

* Widows Vista

* Windows XP

* Windows Server 2003 with Service Pack 2 (SP2) or later

* Windows Server 2008

* Red Hat Enterprise Linux 4 or Red Hat Enterprise Linux 5 (RHEL 4 or RHEL 5)

* SUSE Linux Enterprise Server 9 or SUSE Linux Enterprise Server 10 (SLES 9 or
SLES 10)

Host server (for I/0 attachment only)
Novell NetWare 6.5 with Support Pack 6 or later

Cluster node (for I/O attachment only)
Novell NetWare 6.5 with Support Pack 6 or later

LSIMPE driver
LSIMPE.cdm

Note: Make sure that you install the correct version of the LSIMPE multipath driver.
For more information, see [‘Installing the LSIMPE device driver and NetWare]
jhative failover device driver” on page 56.

Versions of this component are on the latest IBM host bus adapter device driver for
NetWare, on Novell NetWare Support Packs, or on the Novell Web site. Always
select the latest version of this component.

Note: In a Novell NetWare environment, you must manage the DS3000 storage
subsystem by using the direct (out-of-band) method from a Windows or
Linux management station.

Storage subsystem management methods

The Storage Manager software provides the following two methods for managing
storage subsystems:

* The host-agent (in-band) management method (DS3300 and DS3400 only)
* The direct (out-of-band or Ethernet) management method

If you establish management connections from multiple management stations or
hosts to the same DS3000 storage subsystem, it is best practice to have only one
active management connection to the DS3000 storage subsystem at a time, even
though eight simultaneous active management sessions are supported in a DS3000
storage subsystem.
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Host-agent (in-band) management method (not supported for the

DS3200)

When you are using the host-agent (in-band) management method, you manage
the storage subsystems through the 1/O path to the host. The management
information can either be processed in the host or be passed to the management
station through the network connection, as shown in

Note: As of the date of this document, the DS3200 does not support in-band

management.
; Host computer
“«——— 1/O path
’ Controller ‘ ****** v
’ Controller ‘ pomesi

Storage subsystems

<+— Ethernet

Management station
(one or more)

Figure 1. Host-agent (in-band) managed storage subsystems

Managing storage subsystems through the host-agent has the following
advantages:

* You do not have to connect Ethernet cables to the controllers.

* You do not need a Dynamic Host Configuration Protocol/Bootstrap Protocol
(DHCP/BOOQOTP) server to connect the storage subsystems to the network.

* You do not have to perform the controller network configuration tasks that are
described in [Chapter 2, “Preparing for installation,” on page 21

* You must specify only a host name or IP address for the host instead of for the
individual controllers in a storage subsystem. Storage subsystems that are
attached to the host are automatically discovered, if the host-agent service is
installed and running.

Managing storage subsystems through the host-agent has the following
disadvantages:

* The host-agent requires a special logical drive, called an access logical drive, to
communicate with the controllers in the storage subsystem. Therefore, you are
limited to configuring one fewer logical drive than the maximum number that is
allowed by the operating system and the host adapter that you are using.
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 If the connection through the 1/O path is lost between the host and the storage
subsystem, you cannot manage or monitor the storage subsystem.

Note: The access logical drive is also referred to as the Universal Xport Device.

Important: If the maximum number of logical drives are configured in the host,
either use the direct-management method or give up a logical drive for
use as the access logical drive. For more information, see
lsupported logical drives” on page 18/

Required host-agent (in-band) management activities

To establish host-agent (in-band) management connections, complete the following

general tasks:

1. Make the I/O connections between the DS3000 storage subsystem and the host
server.

2. Install TCP/IP on the host server and establish a host IP address. For
instructions for host-managed systems, see [‘Overview of network installation|
[tasks” on page 23]

3. Install the host bus adapter device driver, SMclient, RDAC (MPIO for Windows,
Linux MPP for Linux), and SMagent on the host server.

4. Make sure that the Storage Manager Agent Service starts successfully:

For Windows:

a. Click Start » Settings » Control Panel »+ Administrative Tools » Services.
The Services window opens.

b. Locate the IBM System Storage DS3000 Storage Manager 2 Agent and
make sure that the status is Started.

For Linux: Type ps -elf | grep SMagent and make sure that the Java listening

service is running.

5. Open the Storage Manager Enterprise Management window and add the IP
address of the host server to the management domain. All DS3000 devices that
are recognized by the host server are displayed in the Enterprise Management
window.
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Direct-management (out-of-band) method

When you use the direct-management (out-of-band) method, you manage storage
subsystems directly over the network through a TCP/IP Ethernet connection to each
controller. To manage the storage subsystem through the Ethernet connections, you
must define the IP address and host name for each controller. Each of the storage
subsystem controllers must be connected, through a cable that is connected to the
RJ-45 connector, to an Ethernet network, as shown in

The following illustration shows a system in which storage subsystems are
managed by using the direct-management (out-of-band) method.

Host computer

:47 1/0 path

’ Controller ‘ ***** J

’ Controller ‘ *******

Storage subsystems

<+— Ethernet

Management station
(one or more)

Figure 2. Direct-management (out-of-band) storage subsystems

Managing storage subsystems by using the direct-management (out-of-band)
method has the following advantages:

* The Ethernet connections to the controllers enable you to manage storage
subsystems that are connected to a host running any of the operating systems
that Storage Manager supports through an SMclient management station.

* You do not need an access logical drive to communicate with the controllers. You
can configure the maximum number of logical drives that are supported by the
operating system and the host bus adapter that you are using.

* You can manage and troubleshoot the storage subsystem when there are
problems with the Fibre Channel, Internet SCSI (iSCSI), or SAS links.

Managing storage subsystems by using the direct-management (out-of-band)
method has the following disadvantages:

* In a dual-controller storage subsystem configuration, you need two Ethernet
cables to connect the storage subsystem controllers to a network.

* When you add devices, you must specify an IP address or host name for each
controller.

Chapter 1. Introduction 11



» Network preparation tasks are required. For a summary of the preparation tasks,
see [Chapter 2, “Preparing for installation,” on page 21.|

Important:

» To avoid DHCP/BOOTP server and network tasks, use the controller
default TCP/IP addresses or assign static IP addresses to the
controller (see .

* Create a separate private network aside from the main production
network for managing your DS3000 storage subsystems.

Defining controller TCP/IP addresses
The following table shows the default settings for the storage subsystem controllers.

Table 5. Default controller TCP/IP addresses

Controller IP address Subnet mask
A 192.168.128.101 255.255.255.0
B 192.168.128.102 255.255.255.0

To change the DS3000 storage subsystem controller default TCP/IP address, you
must first make a direct-management connection to the storage subsystem by using
the default TCP/IP addresses.

To change the controller default TCP/IP address by using the Storage Manager

Client program, complete the following steps:

1. In the Enterprise Management window, double-click the storage subsystem for
which you want to define new controller TCP/IP addresses. The Subsystem
Management window opens.

2. Click the Tools tab.

3. On the Tools page, click Change Network Configuration. The Change Network
Configuration window opens.

A2 SIMPLEX IBM System Storage DS3000 Storage |

Tooks = Change Network Configuration

Change Network Configuration

Select controller:
Cortroller in Stot A ¥

Host narme: SIMPLEX_Ctia
Ethernet port: 1
MAC address: DO al:bitd 2brol3

Change configuration (port 1) Advance d
" Oltain configuration fram DHCP/Bootp server
& Specity configuration:

IP address: foneasaos

Subnetmask:  [255.255.0.0

Gateway: 0000

8 Cancel

Figure 3. Change Network Configuration window
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Select the applicable controller tab and enter the applicable TCP/IP address
information for both controllers A and B.

Click OK to apply the new TCP/IP addresses.

Important: Make sure that the new TCP/IP address information is correct
because you will not be able to make a direct management
connection to the storage subsystem again by using the controller
default TCP/IP addresses after they are changed to different values.

Close the Subsystem Management window.

In the Enterprise Management window, delete the storage subsystem entry that
contains the default TCP/IP addresses.

Wait approximately 5 minutes, and then re-establish the management
connection to the storage subsystem by using the new TCP/IP addresses.

Note: You might want to ping the new addresses first to make sure that there is
a good network connection to the controllers before you add the storage
subsystem into the Enterprise Management window.

Required direct-management (out-of-band) management
activities

To establish a direct-management connection, complete the following steps:

1.

Make the Ethernet connections between the DS3000 storage subsystems and
the Ethernet network.

Follow the instructions in|“Overview of network installation tasks” on page 23|for
direct-managed systems.

Install SMclient.

Start the Storage Manager software and add the IP addresses for the DS3000

controllers (A and B). If you have multiple DS3000 storage subsystems, add
each |IP address to the domain.

Chapter 1. Introduction 13



Reviewing a sample network

The following illustration shows an example of a network that contains both a
direct-managed storage subsystem (Network A) and a host-agent-managed storage
subsystem (Network B).

Network A
TCP/IP Ethernet
1/0O path
Storage
subsystem

| | e | | |

Network Host computer  i___| || Management DHCP/BOOTP
management Denver | station server
station (IP address -1 — (one or more)
(for SNMP traps) 192.168.128.112) Host name: Denver_a
(IP address 192.168.128.101)
hardware address 00.a0.b8.02.04.20
Host name: Denver_b

Router (IP address 192.168.128.102)
hardware address 00.a0.b8.00.00.d8

Network B
TCP/IP Ethernet

1/O path

Storage
subsystem

Host computer ] Controller Managgment
Atlanta 3 station
(IP address ~ *---1 Controller (one or more)

192.168.2.22)

Figure 4. Sample network using direct-managed and host-agent managed storage
subsystems

Direct-managed storage subsystem

In|Figure 4} Network A is a direct-managed storage subsystem. Network A contains
the following components:

« A DHCP/BOOTP server

* A network management station (NMS) for Simple Network Management Protocol
(SNMP) traps

* A host that is connected to a storage subsystem through a Fibre Channel, iSCSI,
or SAS /O path

* A management station that is connected by an Ethernet cable to the storage
subsystem controllers

Note: If you use the controller static TCP/IP addresses or default TCP/IP
addresses, you do not have to setup the DHCP/BOOTP server.
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Host-agent-managed storage subsystem

In[Figure 4 on page 14} Network B is a host-agent-managed storage subsystem.
Network B contains the following components:

» A host that is connected to a storage subsystem through a valid 1/O path
* A management station that is connected by an Ethernet cable to the host server

Where to install software components

How you manage the storage subsystems determines where you must install the
various software components.

Management stations
You must install the SMclient component on each management station.

Host servers
You must install the following software components on each host server.

Table 6. Required host software components

QLogic SANsurfer or
Operating system | RDAC SMutil LSIMPE Emulex HBAnywhere

Linux Yes (see note 1) Yes Yes (see note 2)

Windows Server Yes (see note 4) Yes Yes (see note 2)
2003 or Windows
Server 2008

NetWare Yes

VMWare ESX See note 3.
Server

Notes:

1. Linux uses Linux MPP as the multipath driver. For detailed Linux MPP
installation instructions, see [Installing Linux MPP” on page 49|

2. Use Qlogic SANsurfer or Emulex HBAnywhere for IBM Fibre Channel host bus
adapter management and troubleshooting problems in the Fibre Channel path
between the host server host bus adapter and the DS3400 storage subsystem
only.

3. As of the date of this document, the Storage Manager software is not available
for VMware ESX Server operating systems. VMware has a built-in device driver
for multipath operation.

4. Windows uses Storage Manager RDAC (MPIO DSM) as the multipath driver.

Depending on how you want to manage the storage subsystems, you might also
have to install the following additional host software components:

* SMclient (Windows Server 2003 and Linux )
» SMagent (Windows Server 2003 and Linux [with Linux MPP only])

Notes:
1. Install the SMagent on a host server if you want to manage the DS3400 storage
subsystems by using the host-agent management method.

2. You must install the SMclient on a host server if you want the host server to act
as a management station. If the host server is not connected to a network, you
must install TCP/IP software and assign an IP address.
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Creating a SAN-attached configuration (Fibre Channel)

This section contains the following topics:

* Preparing for a SAN-attached configuration

» Steps for setting up a SAN-attached configuration

» Connecting host bus adapters in a Fibre Channel switch environment

Preparing for a SAN-attached configuration
Before you create a SAN-attached configuration, read the following information:

* Make sure that multiple host bus adapters within the same server cannot "see”
the same DS3400 controller port.

* A multipath configuration requires two host bus adapters per host system, each
in a separate switch zone that is connected to one of the two controllers.

« Each Fibre Channel host bus adapter on each host, and the controller port on
each DS3000 storage subsystem, should be in its own fabric zone, if they are
connecting through a single Fibre Channel switch. If multiple adapters or
controller ports are in the same zone, you might encounter extended failover
delays or additional failovers because device resets are being propagated
throughout the zone.

Note: Single host bus adapter configurations are allowed. If you have a single host
bus adapter in a SAN-attached configuration, the controller must have a
Fibre Channel connection to the host bus adapter through a switch, and both
controllers must be within the same SAN zone as the host bus adapter.

Attention: If a path fails in a single host bus adapter configuration, a loss of
access to the data can occur.

Setting up a SAN-attached configuration
To set up a SAN-attached configuration, complete the following steps:
1. Connect the host bus adapters to the switch or switches.
2. Connect the DS3000 storage subsystems to the switch or switches.
3. Set the required zones on the Fibre Channel switch or switches, if applicable.

Note: For information about zoning and enabling zones, see the documentation
that comes with the switch.

4. Configure the system, and then verify the configuration by logging in to the
switch to view the system.

For more information about setting up a DS3000 storage subsystem, see the Quick
Installation Guide and the other documentation on the support CD that comes with
the storage subsystem.

Connecting host bus adapters in a Fibre Channel switch environment

When you connect Fibre Channel host bus adapters in host servers to DS3000
storage subsystem host ports in a Fibre Channel switch environment, you should
establish one-to-one zones between the host bus adapter and DS3000 host ports. If
multiple adapters or controller ports are in the same zone, you might encounter
extended failover delays or additional failovers because device resets are being
propagated throughout the zone.
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For instructions for setting up a zone inside a Fibre Channel switch, see the
documentation that comes with the Fibre Channel switch.

You can find links to switch documentation at |http://www.ibm.com/servers/storage/|

lsupport/san/index.htmi}

Configuration types

You can install the Storage Manager software in either of the two following

configurations:

» Standard (noncluster) configuration
» Cluster server configuration

Note: The illustrations of cluster server configurations in the following sections
do not pertain to NetWare or Linux.

Standard (noncluster) configuration
Figure 5| shows a sample standard (noncluster) configuration.

’ Controller

|

’ Controller

|

,,,,,,,

Storage subsystems

<+— Ethernet

MPIO (for Windows),
MPP (for Linux),
SMutil, SMagent

Host computer

“«———1/0 path

The SMclient software
can also be installed
on the host computer.

SMclient

Management station

Figure 5. Sample standard (noncluster) configuration
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Cluster server configuration for Windows
shows a sample cluster server configuration.

MPIO, SMutil, SMagent

| & a |

Ethernet —

SMclient

Cluster server Cluster server
node A N node B

The SMclient software
can also be installed on
the cluster nodes.

For Fibre Channel,

a managed hub or
switch can be used
between the cluster
server nodes and the
storage subsystem.

Management station !
(one or more) i

4 1/O path

’ Controller ‘ ”””” !

,,,,,,,,,

’ Controller ‘ !

Storage subsystem

Figure 6. Sample cluster server configuration

Number of supported logical drives

The supported logical drive limits for Windows Server, Linux, and NetWare are as
follows:

* Windows server supports a maximum of 255 LUNs (LUNs 0 through 254) when
you use IBM host bus adapters and their supported device drivers.

» Linux supports up to 256 logical drives per storage subsystem (LUNs 0 through
255) when you use IBM host bus adapters and their supported device drivers.

For the maximum total number of logical drives that are supported in the host
server and the maximum number of logical drives that can be mapped from a
storage subsystem, see your Linux kernel documentation.

* NetWare 6.5 with SP3 or later support up to 256 logical drives per storage
subsystem (LUNs 0-255) when you use IBM host bus adapters and their
supported device drivers.

* The maximum number of logical drives that a DS3000 storage subsystem
supports is listed in[Table 7 on page 19
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Table 7. Maximum number of logical drives per storage subsystem

Maximum logical
drives

Maximum logical
drives per storage
unit partition

Maximum
FlashCopy logical
drives

Maximum Logical
Drive Copy logical
drives

256

32 (See note )

128

255

Notes:

1.

A maximum of four partitions is supported for base DS3000 models. To upgrade
from 4 to 16 partitions, you must purchase the DS3000 Partition Expansion
License.

Each standard logical drive supports a maximum of four FlashCopy logical
drives.

The host-agent management method uses a special logical drive, called an
access logical drive, to communicate with the controllers on the storage
subsystem. The access logical drive uses one of the available LUNs. Therefore,
managing storage subsystems with the host-agent software limits you to one
fewer LUN than the maximum number that is supported by the operating system
and the host adapter. The access logical drive is also referred to as the
Universal Xport Device.

Important: The FlashCopy logical drive cannot be added or mapped to the same

server that has the base logical drive of the FlashCopy logical drive in a
Windows Server 2003 or NetWare environment. You must map the
FlashCopy logical drive to another server.
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Chapter 2. Preparing for installation

This chapter provides information to help you plan the installation of the Storage

Manager software.

See the applicable sections in this document to install the Storage Manager 2 Client
and host software for a particular operating system. When you have completed the
Storage Manager 2 software component installation procedures, perform the

rocedures in [Chapter 8, “Completing the Storage Manager software installation|

and configuration,” on page 65[and|Chapter 9, “Completing storage-management|

tasks for Windows hosts,” on page 97

Planning and preparing for a Windows installation

shows the installation sequence for the Storage Manager software
components and provides information to help you plan for the installation of the
Storage Manager software for Windows Server 2003 or Windows Server 2008.

Table 8. Software component installation sequence in a Windows environment

System type

Software installation sequence

Management station | SMclient
Host server and 1. IBM host bus adapter device driver
cluster node . . .
2. Microsoft Windows Server 2003 Service Pack 2 (SP2)
3. Microsoft hotfix KB932755 (for Windows Server 2003 only)
4. Storage Manager host software package, which can install the

following components:

SMclient (optional)

SMclient is required if you manage the storage subsystem from
the host server.

MPIO (required)

MPIO (also referred to as MPIO DSM) is installed as the RDAC

failover driver for Windows Server 2003 or Windows Server
2008.

SMagent (optional)
SMagent is installed when you select the Typical Installation

option in the Storage Manager installation wizard. It is required
if you use the host-agent management method.

SMutil (required)

SMutil contains the hot_add, SMdevices, and SMrepassist
utilities.

5. Host bus adapter management software (Fibre Channel only)
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Planning and preparing for a Linux installation

shows the installation sequence for the Storage Manager software
components and provides information to help you plan for the installation of the
storage management software for Linux.

Table 9. Software component installation sequence in a Linux environment

System type

Software installation sequence

Management station
(and any host server
in use as a

management station)

Storage Manager Client (SMclient)

See [‘Installing the Storage Manager 2 software using the installation|
[wizard” on page 47/

Host server and
cluster node

. IBM host bus adapter device driver (Linux version)
2. Linux MPP (required)
Linux MPP is installed as the RDAC failover driver for Linux.
See[‘The Linux MPP package” on page 48]

3. Storage Manager host software package, which can install the
following components:
» SMclient (optional)
SMclient is required if you manage the storage subsystem from
the host server.
» SMagent (optional)

SMagent is required if you use the host-agent (in-band)
management method. You must first install Linux MPP (see step
@- The direct (out-of-band) management method is preferred in
a Linux environment.

See[“Installing the Storage Manager 2 software using the]
linstallation wizard” on page 47

*  SMutil (required)

SMutil contains the hot_add, SMdevices, and SMrepassist
utilities.

4. (Optional) Host bus adapter management software and QLRemote
agent (QLogic SANsurfer only)

Complete this step to provide Fibre Channel host bus adapter
diagnostic functions. See the installation documentation that

comes with the host bus adapter.

Note: Linux MPP is provided separately from the Storage Manager host software
package. There are two Linux MPP packages, one for each type of kernel:

* 2.6 kernel (RHEL 4, SLES 9, and SLES 10) for RDAC Revision B
» 2.6 kernel (RHEL 5 and SLES 10 SP1) for RDAC Revision C

Planning and preparing for a NetWare installation

The Storage Manager software is not available for the NetWare operating system

environment.

To manage a DS3000 storage subsystem that is connected to a NetWare host
server, you must install the Windows or Linux version of the Storage Manager
SMclient program on a management station and make an out-of-band management
connection to the DS3000 storage subsystem.
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shows the installation sequence for the Storage Manager software
components and provides information to help you plan for the installation of the
storage management software.

Table 10. Software component installation sequence in a Novell NetWare 6.5 environment

System type Software installation sequence

Management station | Storage Manager Client (SMclient)

(Windows or Linux
management station
only)

NetWare host server
and cluster node

Novell NetWare native failover device driver (MM.NLM)
LSIMPE.cdm driver
Host bus adapter device driver

P wbd =

(Optional) NetWare agent component of the host bus adapter
management software

Overview of network installation tasks

To begin installing the storage management software, make sure that the network
components are set up and operating correctly, and that you have the host and
controller information that is required for the software to operate correctly.

The following sections provide an overview of the tasks that are involved in setting
up a network installation for direct-managed and host-managed storage
subsystems.

Direct-managed storage subsystems: Network installation overview

Setting up a network installation of a direct-managed system involves the following
general tasks:

1.

Install all hardware components (host servers, storage subsystems, and cables)
that you want to connect to the network. For installation information, see the
documentation that comes with the specific hardware device.

Establish a naming convention for the storage subsystems that are connected to
the network. For more information, see ['Step 1: Naming the storage|
[subsystems” on page 24)

Record the storage subsystem names and management types in|Appendix A,|

[‘Storage subsystem and controller information record,” on page 105.|An
example of a completed information record is shown in [Table 11 on page 25|

Note: Throughout the remaining steps, return to|Appendix A, “Storage]
[subsystem and controller information record,” on page 105 to record
information such as hardware Ethernet addresses and IP addresses.

If you are using a default controller IP address, go to step .

Otherwise, obtain the TCP/IP address and host name for each of the controllers
in the storage subsystems on the network from the network administrator. See
[‘Step 3: Assigning IP addresses to hosts and controllers” on page 25

Use controller static IP addresses (preferred); otherwise, set up a
DHCP/BOOTP server to provide network configuration information for a specific
controller.
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6.

7.

Make sure that the TCP/IP software is installed. For more information, see |“Step_>|
5 (for Windows Server 2003 and Windows Server 2008): Verifying the TCP/IP|
protocol and setting up the host or DNS table” on page 28|

Power-on the devices that are connected to the network.

Host-managed systems: Network installation overview

The following steps provide an overview of the tasks that are involved in setting up
a network installation of a host-managed system:

1.

6.

Install all hardware components (host servers, storage subsystems, and cables)
that you want to connect to the network. For installation information, see the
documentation that comes with the specific hardware device.

Establish a naming convention for the storage subsystems that are connected to
the network. For more information, see ['Step 1: Naming the storage|

Record the storage subsystem names and management types in|Appendix A,|
[‘Storage subsystem and controller information record,” on page 105.]An
example of a completed information record is shown in[Table 11 on page 25|

Note: Throughout the remaining steps, return to|Appendix A, “Storage]
[subsystem and controller information record,” on page 105 to record
information such as hardware Ethernet addresses and IP addresses.

Obtain the IP address and host name of the host server on which the
host-agent software will run from the network administrator. See f‘Step 3:|
[Assigning IP addresses to hosts and controllers” on page 25.

Note: Host-managed storage subsystems are supported with the DS3300 and
DS3400 only.

Make sure that the TCP/IP software is installed. For more information, see |“Ste§|
5 (for Windows Server 2003 and Windows Server 2008): Verifying the TCP/IP|
protocol and setting up the host or DNS table” on page 28|

Power-on the devices that are connected to the network.

Step 1: Naming the storage subsystems

As you set up your network, decide on a naming convention for the storage
subsystems. When you install the storage management software and start it for the
first time, all storage subsystems in the management domain are displayed as
<unnamed>. Use the Subsystem Management window to rename the individual
storage subsystems.

Consider the following factors when you name storage subsystems:

There is a 30-character limit. All leading and trailing spaces are deleted from the
name.

Use a unique, meaningful naming scheme that is easy to understand and
remember.
Avoid arbitrary names or names that might quickly lose their meaning.

The software adds the prefix Storage Subsystem when storage-subsystem names
are displayed. For example, if you name a storage subsystem Engineering, it is
displayed as Storage Subsystem Engineering.
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Step 2: Recording the storage subsystem names

After you decide on a naming scheme, record the storage subsystem names in the
blank information record form in|Appendix A, “Storage subsystem and controllei
linformation record,” on page 105).

Table 11]shows a sample information record for the network shown in
page 1

. This network contains storage subsystems that are managed by using
both the direct-management and host-agent-management methods.

Table 11. Sample information record

Storage Management |Controllers: IP addresses and Host-IP address

subsystem name | method host name and host name
Controller A Controller B

Finance Direct IP address = IP address =

192.168.128.101 |192.168.128.102

Host = Denver_a | Host = Denver_b

Engineering Host-agent IP address =
192.168.2.22

Host = Atlanta

Step 3: Assigning IP addresses to hosts and controllers

If you plan to manage your storage subsystem by using the out-of-band
management (direct-management) method, assign a unique IP address for every
controller in all storage subsystems on the network. Record the IP address for each
controller in the information record dAppendix A, “Storage subsystem and controllerI
information record,” on page 105). Then, go to ['Step 4: Setting up a Windows|
Server 2003 or Windows Server 2008 DHCP or BOOTP-compatible server” on page|

56]

Note: To avoid performing DHCP/BOOTP server and network tasks, use the
controller default TCP/IP addresses or assign static IP addresses to the
controllers. If you are not able to use the controller default TCP/IP address to
assign the static TCP/IP address, see the information in ['Direct-management
[(out-of-band) method” on page 11.

Then, go to[“Step 5 (for Windows Server 2003 and Windows Server 2008)]
[Verifying the TCP/IP protocol and setting up the host or DNS table” on page 28

You can establish the out-of-band management connection to the DS3000 storage
subsystem by using the default IP addresses of 192.168.128.101 for controller A
and 192.168.128.102 for controller B. You can change the IP addresses by using
the Storage Manager Client Subsystem Management window.

For host-agent management only: If you plan to manage the DS3300 or DS3400
storage subsystem by using the host-agent management method, assign an IP
address for each host on which you will install the host-agent software. Record the
IP address for each host in the information record in[Appendix A, “Storage]
subsystem and controller information record,” on page 105} then, go to[“Step 5 (for
Windows Server 2003 and Windows Server 2008): Verifying the TCP/IP protocoll
and setting up the host or DNS table” on page 28.|
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Step 4: Setting up a Windows Server 2003 or Windows Server 2008
DHCP or BOOTP-compatible server

To manage storage subsystems directly through the Ethernet connection to each
controller, you can set up a DHCP or BOOTP-compatible server and configure the
following options:

* Router/gateway

* DNS server

* Host name

+ DNS

This section provides instructions for setting up a DHCP server on Windows Server
2003 or Windows Server 2008.

You must use a version of DHCP that supports BOOTP static addressing. To use a
DHCP server, a DHCP Manager must be installed. If a DHCP Manager is already
installed in the system, see [‘Creating a scope and setting up a DHCP server on
Windows Server 2003” on page 27.|

Installing the DHCP Manager for Windows Server 2003

To install the DHCP Manager, complete the following steps:

1. Click Start » Control Panel » Add or Remove Programs. The Add or Remove
Programs window opens.

2. In the left pane, click Add/Remove Windows Components. The Windows
Components Wizard window opens.

3. In the Components field, select Networking Services. Then click Details. The
Networking Services window opens.

Note: Do not select the check box; you do not want to install all of the
Networking Services subcomponents.

4. In the Subcomponents of Networking Services field, select Dynamic Host
Configuration Protocol (DHCP). Click OK.

5. In the Windows Components Wizard window, click Next to start the installation
process.

6. If you are prompted, type the full path to the Windows Server 2003 distribution
files and click Continue.

7. After the installation has been completed successfully and the Windows
Components Wizard window opens, click Finish.

8. Close the Add or Remove Programs window. You are now ready to perform the

tasks in [‘Creating a scope and setting up a DHCP server on Windows Served
[2003” on page 27

After you install the DHCP Manager, see the DHCP Manager online help for more
information.
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Creating a scope and setting up a DHCP server on Windows Server
2003

A scope defines a group of controllers by their IP addresses. You must create and
configure a scope so that dynamic IP addresses can be assigned to controllers on
the network. See|Appendix A, “Storage subsystem and controller informationl
lrecord,” on page 105.|Before you begin, read the instructions to determine what
information is required. Then request the information from your network
administrator.

To create a scope and to set up a DHCP server, complete the following steps:
1. Click Start »+ Administrative Tools * DHCP. The DHCP window opens.

2. In the Console tree, right-click the server that you want to configure, and then
click New Scope. The New Scope Wizard starts.

3. Follow the on-screen instructions to define the scope of IP addresses for
TCP/IP clients. You will define the following fields:

» Scope name and description

* |P address range and the subnet mask for the controllers that you are
configuring

» |P addresses that you want to exclude from the IP address range
e |IP address lease duration
e Common DHCP options:

— IP address for a router

— Domain name and DNS servers or Windows Internet Naming Service
(WINS) servers

4. When you have defined the scope, click Yes, | want to activate this scope
now. The New Scope Wizard window opens.

5. Click Finish. The DHCP window opens.
6. In the Console tree, expand the Scope folder.

7. Right-click Reservations. Then select New Reservations. The New
Reservations window opens.

8. To define the IP address reservation, type the following information:
* Reservation name
» |IP address
* Ethernet hardware MAC address
» Description
9. In the Supported Type field, select Both (DHCP and BOOTP).
10. Click Add.
11. Repeat steps Iﬂthrough for each controller in the network.

12. Restart the DHCP server and then restart the storage subsystem so that all
the modifications are applied.

13. Go to[‘Step 5 (for Windows Server 2003 and Windows Server 2008): Verifying|
tthe TCP/IP protocol and setting up the host or DNS table” on page 28|

Chapter 2. Preparing for installation 27



Installing a DHCP server and creating a scope for Windows Server

2008

To install and configure the DHCP Manager, complete the following steps:

1.
2.
3.

10.

11.

Click Start » Control Panel. The Control Panel window opens.
Click Turn Windows features on or off. The Server Manager window opens.

In the Roles Summary section, select Add Roles. The Add Roles Wizard
window opens. Click Next.

In the Select Server Roles section, select DHCP (Dynamic Host
Configuration Protocol) Server and click Next.

The Introduction to DHCP Server window opens. After reviewing the
information, click Next.

The Specify the IPv4 DNS Server Settings window opens. Specify the Parent
Domain, a preferred DNS Server IPv4 Address (if needed), and an Alternate
DNS Server IPv4 Address. Then, click Next.

The Specify IPv4 WINS Server Settings window opens. Provide the WINS
information (if needed), then click Next.

The DHCP Scopes window opens. Select Add to add a new DHCP scope.
The Add Scope window opens and the following information must be defined:

Scope Name

Starting IP Address

Ending IP Address

Subnet Mask

Default Gateway (optional)

Subnet type

After you have defined the information, click OK, and then click Next.

The Configure DHCPv6 Stateless Mode window opens. Click Enable to enable
DHCPv6 and then configure the IPv6 DNS settings. Click Disable to disable
the DHCPv6 stateless mode for this server. Click Next.

The DHCP Server Selection Confirmation window opens. Review the
information and click Next to start the installation process.

After the installation is completed, click Close.

Step 5 (for Windows Server 2003 and Windows Server 2008): Verifying
the TCP/IP protocol and setting up the host or DNS table

To enable SMclient functions, you must install the TCP/IP networking stack, which
requires that you perform the following two tasks:

* Make sure that the TCP/IP protocol software is installed on the management

station or the host server on which you will install SMclient and from which you
will run SMclient.

» Set up the host or DNS table.

Note: Make sure that the host names for the controllers match the IP addresses for

the controllers.
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To make sure that the TCP/IP protocol software is installed and to set up the host
or DNS table, complete the following steps:

1. Open the Windows Explorer window.

2. Right-click the My Network Places folder and select Properties. The Network
Connections window opens.

3. Right-click a defined network connection and select Properties.

4. In the network_name Properties window that opens, in The Connection Uses
The Following Items area, select the Internet Protocol TCP/IP check box (if it
is not already selected) and click OK.

5. Update the DNS table to specify a host name to associate with an IP address. If
you do not have a DNS server, use a text editor to update the hosts file to link
the IP address and controller name entries. The following example shows the
host tables for the controllers that are connected to Network A, as shown in
[Figure 4 on page 14

6. Attempt to ping one of the controller devices that are listed in the
c:/windows/system32/drivers/etc/hosts file. In the following example, this is
performed by typing ping denver_a from an MS-DOS command prompt.

# Copyright (c) 1993-1999 Microsoft Corp.

# This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

# This file contains the mappings of IP addresses to host names. Each

# entry should be kept on an individual line. The IP address should

# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.

# Additionally, comments (such as these) may be inserted on individual

# lines or following the machine name denoted by a '#' symbol.

# For example:

# 102.54.94.97 rhino.acme.com # source server
# 38.25.63.10 X.acme.com # x client host
127.0.0.1 localhost

192.168.128.101 denver_a

192.168.128.102 denver_b
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Step 5 (for Linux): Verifying the TCP/IP protocol and setting up the
host or DNS table

The default installation process installs the TCP/IP software package. To make sure
that TCP/IP software package was installed successfully, open a shell prompt and
type ifconfig. If you see an ethO or eth1 interface, the IP protocol is enabled.

To set up the host or DNS table, complete the following steps. Make sure that the
host names for the controller match the IP addresses for the controllers.

1. Update either the host table or the DNS table to specify a host name to
associate with an IP address. If you do not have a DNS table, edit the host
table that is in the /etc/hosts file. Your directory might be different if the
operating system is not installed on the root.

2. To manage storage subsystems through a firewall, configure the firewall to open
port 2463 to TCP data.

3. Attempt to ping one of the controllers that are listed in the /etc/hosts file.

The following example shows a Linux host file.

# Do not remove the following Tine, or various programs
# that require network functionality will fail.

127.0.0.1 rh71_8500 Tocalhost.Tocaldomain
102.54.94.97 rhino.acme.com x.acme.com
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Chapter 3. Installing the Storage Manager software in a
standard Windows configuration

Note: If you are configuring the system for clustering, see [Chapter 4, “Installing thel
Storage Manager software in a Windows cluster server environment,” o

page 39.|

This chapter describes how to install the Storage Manager software for Windows
Server in a standard (noncluster) configuration.

Before you install the software, read the following information:

» For correct installation, make sure that you have completed all preparation tasks
that are described in [Chapter 2, “Preparing for installation,” on page 21.|

* Always check for a readme file on any installation media. The readme file
contains important information that was not available when this document was
prepared.

« This version of the Storage Manager software does not support 64-bit versions of
Windows XP. All administrator functions that use the Storage Manager software
must be performed from a 32-bit management station.

» Configure the event monitor on only one management station to prevent the
receipt of duplicate event messages. Note that duplicate alerts are also sent if
the Enterprise Management window and the SMmonitor are running
simultaneously.

* Do not restart the system during the installation process. You will restart the
system after you install all Storage Manager software components.

New installation process

You can install the Storage Manager software components either on host servers
only or on both host servers and management stations.

Management station: A management station is a system that you use to manage

the storage subsystem. You can attach it to the storage subsystem in either of the

following ways:

» Through a TCP/IP Ethernet connection to the controllers in the storage
subsystem

» Through a TCP/IP network connection to a host server with host-agent software
installed on it, which in turn is directly attached to the storage subsystem through
the 1/O path

You must install the Storage Manager SMclient software on a management station.

Host server: A host server (or host) is a server that is connected directly to the
storage subsystem through an 1/O path.

Important: Make sure that you install the host bus adapter and device driver before
you install the Storage Manager software.
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To begin the installation on the management station, see [Installing the Storage|
[Manager host software packages” on page 34|

To begin the installation on a host, see [“Installing the Storport miniport host bug
fadapter device driver.”|

Installing the Storport miniport host bus adapter device driver

An IBM Fibre Channel, iSCSI, or SAS host bus adapter provides the interface
between a host server and a DS3000 storage subsystem. IBM Fibre Channel,
iSCSI, and SAS host bus adapters are high-performance, direct memory access,
bus-master host adapters that are designed for high-end systems. The Fibre
Channel host bus adapters support all Fibre Channel peripheral devices that
support private-loop, direct-attach, and fabric-loop attachment. The IBM host bus
adapter device driver enables the operating system to communicate with the host
bus adapter.

The Storage Manager software provides the multi-path support for a Fibre Channel,
iSCSI, or SAS host bus adapter device driver based on the Microsoft Storport
miniport device-driver model. The Storport miniport device-driver model was
introduced in the Microsoft Windows Server 2003 release as a replacement for the
SCSlport miniport device driver model. It is the only supported device driver model
for Windows Server 2003 x64 editions, which support the AMD64 and EM64T
servers.

To support Storport miniport device drivers, Service Pack 2 and the latest Storport
miniport hotfix must be installed in the Windows Server 2003 operating system. You
can download the latest Storport hotfix from |http://www.support.microsoft.com/kb/|
. See the Storage Manager readme file for Microsoft Windows
operating systems for other requirements, such as controller firmware versions or
other Microsoft updates, and for information about the latest versions of the hotfix.

Storage Manager software for Windows Server 2003 and Windows

Server 2008

The Storage Manager software package contains the following components for
Microsoft Windows Server 2003 and Windows Server 2008:

« Storage Manager Agent (SMagent)

« Storage Manager Utility (SMutil)

« Storage Manager Client (SMclient)

» Storage Manager redundant disk array controller (RDAC)

Note: The Storage Manager RDAC installs the multipath I/O (MPIO) Device
Specific Module (DSM) multipath driver for Windows. The Storage
Manager RDAC is different from the Linux multipath proxy (MPP)
multipath driver.

Install the Storage Manager Client (SMclient) on the management station. Installing
the SMclient on a host management station is optional.

Install the following components only on the host:
» Storage Manager RDAC (MPIO)

» Storage Manager Agent (SMagent)

« Storage Manager Utility (SMutil)
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Storage Manager Client

The Storage Manager Client (SMclient) component provides the graphical user
interface (GUI) for managing storage subsystems. The SMclient contains two main
components:

* Enterprise Management. Use the Enterprise Management component to add,
remove, and monitor storage subsystems within the management domain.

* Subsystem Management. Use the Subsystem Management component to
manage the components of an individual storage subsystem.

The Event Monitor is a separate program that is bundled with the SMclient. If the
Event Monitor is installed, it monitors storage subsystems whenever the Enterprise
Management window is closed. It runs continuously in the background and can
send alert notifications in the event of a critical problem.

Note: You must enable the Event Monitor if you want to use automatic ESM
firmware synchronization.

When you install a new ESM into an existing EXP3000 that is attached to a
DS3000 storage subsystem that supports automatic ESM firmware synchronization,
this feature resolves firmware mismatch conditions by automatically synchronizing
the firmware in the new ESM with the firmware in the existing ESM.

Note: The Event Monitor can perform ESM firmware synchronization only if the
.esm file is in the c:\program files\ibm_ds3000\client\data\firmware\esm\
directory. Each time a new ESM firmware download is performed from the
Storage Manager software, the .esm file is automatically added to this
directory.

Storage Manager RDAC (MPIO)

The Storage Manager RDAC (MPIO) contains the multipath driver that is required
for controller failover support when a component on the host I/O path fails.

Storage Manager Agent

The Storage Manager Agent (SMagent) provides a management conduit for the
SMclient to configure and monitor the DS3300 and DS3400 storage subsystem
through the 1/0 path. The agent also provides local or remote access to the
SMclient, depending on whether the SMclient is installed on the host or on a
network management station over the TCP/IP network.

Note: As of the date of this document, the DS3200 does not support in-band
management.

Storage Manager Utility

The Storage Manager Utility suite enables you to discover newly mapped logical
drives and to list the currently mapped logical drives for the host. This software
package contains the following components:
* hot_add utility
Use the hot_add utility to register newly created logical drives with the operating
system. For more information, see the online help.
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* SMdevices utility
Use the SMdevices utility to associate storage subsystem logical drives with
operating-system device names. For more information, see[‘Using the SMdevices|
[utility” on page 98]

* SMrepassist utility
Use the SMrepassist utility to flush cached data before you create a FlashCopy
or VolumeCopy image. For more information, see ['Using the SMrepassist utility’]
on page 99.

Note: The SMrepassist utility is a Windows-only utility. Unmount the file system
if you are using a non-Windows operating system.

Installing the Storage Manager host software packages

This section describes how to install different components of Storage Manager host
software on management stations and host servers that run Windows operating
systems.

Before you install the software, make sure that the management station or host
server has at least 220 MB of available disk space for the installation software
package, the temporary files during installation, and the final files after the
installation.

Important: When you install SMclient on a stand-alone host and manage storage
subsystems through the 1/0 path and not through the network, you
must install the TCP/IP software on the host and assign an IP address
to the host.

All four components of the Storage Manager host software, SMclient, Storage
Manager RDAC (MPIO), SMagent, and SMutil, are packaged in a single host
software package installer. You can install up to four packages by using this host
software package installation program.

Note: The Microsoft Windows XP and Windows Vista operating systems support
the Storage Manager Client package only. Do not install any other Storage
Manager software packages on Windows XP or Windows Vista. MPIO is not
supported on Windows XP or Windows Vista.

To install the Storage Manager host software packages on either a host server or
management station, complete the following steps.

Important: These installation instructions are not for host servers with SAN-boot or
Remote-boot disk. SAN-boot and Remote-boot disk are supported only
by DS3300 and DS3400 storage subsystems.

1. Before you install this software, close all other programs.
2. Insert the IBM System Storage DS3000 Support CD into the CD drive.

Note: If you downloaded the Storage Manager host software package for
Windows from the DS3000 support Web site, you must extract the files
from the downloaded .zip file into a specific directory. Go to this
directory and select the Windows directory to get access to the
Windows host software package installation program. Go to step

page 39
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3. From the Windows desktop, double-click the My Computer icon. The My
Computer window opens.

4. Double-click the CD drive that contains the Support CD. The CD window
opens.

5. Select the applicable directory on the CD for your operating system
architecture.

Directory Operating System

Windows_x86_32bit Windows Server 2003 x86 32-bit edition
(IA32) Server, Enterprise Edition and
DataCenter

Windows Server 2008 x86 32-bit edition
(IA32) Server, Enterprise Edition and
DataCenter

Windows_x64_64bit Windows Server 2003 x64 64-bit edition
(AMD64 and EM64T) Server, Enterprise
Edition and DataCenter

Windows Server 2008 x64 64-bit edition
(AMD64 and EM64T) Server, Enterprise
Edition and DataCenter

6. To start the host software package installer, double-click the executable (.exe)
file, such as SMIA-WSxxx.exe.

The InstallAnywhere Installation wizard window opens while the software is
loading. Follow the instructions in each window of the wizard.

7. When the Select Installation Type window opens, you can select one of the

following options (see [Figure 7 on page 36):

« Typical (Full Installation): This default selection installs all of the packages
on the system. This is a safe choice if you do not know which installation
type to select. This option installs all four host software components:
SMclient, MPIO, SMagent, and SMutil. This is the default selection for a
host running a supported server operating system such as Microsoft
Windows Server, SUSE Linux Enterprise Server, or Red Hat Enterprise
Linux.

* Management Station: This selection installs the software that is required to
configure, manage, and monitor a storage subsystem. This option is for the
workstation or management computer. This option installs the SMclient
program only. This is the default selection for a host running a supported
client operating system such as Microsoft Windows XP or Windows Vista.

* Host: This selection installs the storage subsystem server software. Use
this type of installation for the host (server) that is connected to the storage
subsystem (Windows Server 2003 and Windows Server 2008 only). This
option installs all host software components except the SMclient program.

« Custom: This selection enables you to customize the features that are to be
installed.

Important: You must install the MPIO package before you can install and
use the Storage Manager Agent.
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Figure 7. Select Installation Type window

8.

Click Next.

If there are previously installed Storage Manager software packages, the
Overwrite Warning window opens.

If the Overwrite Warning window opens, click OK.

The Automatically Start Monitor window opens. This is the event monitor
service that will monitor the specified DS3000 storage subsystems and forward
any critical alerts from those subsystems when the SMclient program is not
running.

On the Automatically Start Monitor window, select the applicable option for
your system.

Notes:

a. To enable automatic ESM firmware synchronization, you must enable the
Event Monitor. Select Automatically Start Monitor. For more information,
see [‘Automatic ESM firmware synchronization” on page 86

b. If you start the Event Monitor Service on multiple systems, you might
receive duplicate error messages from the same storage array. To avoid
receiving duplicate error messages, start the Event Monitor on only one
system that will run continuously.

Click Next.

The Pre-Installation Summary window opens.

Click Install.
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The Installing IBM DS3000 Storage Manager window opens while the software
is being installed. The Installation/Remove status window might also open
throughout the installation process. After the software is installed, the Install
Complete window opens.

Important:

If you cancel an installation before the installation is completed (while the
progress bar is still visible), the installation might not clean up the canceled
installation correctly, and the host-software installation wizard creates an
installation log. Also, the Add/Remove Program window might show that the
program is already installed. However, when you try to uninstall it, an
uninstallation error is displayed, and you are asked whether you want to
remove the entry from the Add/Remove program list. Click Yes to remove the
entry. Then, you must delete the .xml file from one of the following directories:

* For Windows Server 2003 32-bit edition or Windows Server 2008 32-bit
edition:
Windows_boot_drive_letter:\\Program Files\Zero G Registry

* For Windows Server 2003 64-bit edition:
Windows_boot_drive_letter:\Program Files (x86)\Zero G Registry

The Windows_boot_drive_letter:\Program Files\Zero G Registry directory might
be hidden from the normal Windows Explorer view. If this is the case, change
the settings of the Windows Explorer to Show hidden files and folders.

If you cancel the installation before the progress bar is visible, the installation
wizard cleans up the canceled process correctly. You do not have to do
anything before you start the wizard again.

13. Make sure that the Yes, restart my system option is selected.

14. Click Done.

Several files and program packages are installed to the directory that you
specified previously in the procedure. The default directories are as follows:

* For Windows Server 2003 32-bit edition or Windows Server 2008 32-bit
edition:
Windows_boot_drive_letter:\Program Files\IBM_DS3000

* For Windows Server 2003 64-bit edition:
Windows_boot_drive_letter:\Program Files (x86)\IBM_DS3000

The installation is completed, and Windows is restarted.

Important: If you repeatedly cancel an installation or uninstallation before the
process is completed and you try to install the software again, the installation
process might not work, and the software might not be installed after the
installation process is completed. The Install Complete window indicates where
the software is installed, but the software is not there. If this problem occurs
delete the .xml file from the applicable default directory that is listed in step

on page 36
To make sure that the software packages were installed, go to [‘Verifying the

linstallation” on page 38|
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Verifying the installation

To make sure that the host-software package installer ran successfully, complete
the following steps:

1.

Select Start » Settings » Control Panel.

The Control Panel window opens. Select Add/Remove programs. The
Add/Remove Programs Properties window opens.

Find the IBM DS3000 Storage Manager Host Software entry. The entry has the
applicable version number, for example, 02.17.x5.00.

If the installation was successful (no failure reported), go to I(—Dhapter 8,|
“Completing the Storage Manager software installation and configuration,” on

age 65.|Otherwise, repeat the steps in [‘Installing the Storage Manager host
software packages” on page 34/ If the failure remains, contact your

technical-support representative.

For information about uninstalling the Storage Manager software components in
Windows, see [‘Uninstalling storage management software components” on page|

Configuring storage management

After you install the Storage Manager software, complete the following tasks that
are described in [Chapter 8, “Completing the Storage Manager software installation|

tand configuration,” on page 65|

Performing an initial automatic discovery of storage subsystems
Adding storage subsystems

Naming storage subsystems

Configuring alerts

Configuring host access

Defining host groups

Creating arrays and logical drives

Managing iSCSI settings (DS3300 only)

Downloading controller firmware and NVSRAM
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Chapter 4. Installing the Storage Manager software in a
Windows cluster server environment

This chapter describes how to install the Storage Manager software in a Windows
cluster server environment. Before you install the software, complete all the
preparation tasks that are described in[Chapter 2, “Preparing for installation,” on|

Important: Always check the Storage Manager software readme file for your
operating system before you install the software. A readme file contains
important information that was not available when this document was
prepared.

Preinstallation considerations

The hardware installation involves installing host bus adapters and storage
subsystems. Before you begin the installation of the DS3000 Storage Manager
software, make sure that all hardware components are installed correctly for the
cluster server configuration.

Configuration options
You can connect the storage subsystem to the cluster nodes either directly or
through switches (for iISCSI and Fibre Channel host bus adapters only).
shows typical direct-attached or Fibre Channel switch connection
configurations. Both configurations provide full redundancy.
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Figure 8. Installing the storage subsystem in a Fibre Channel, iSCSI, or SAS network

Host bus adapters

For specific host bus adapter installation requirements and procedures, see the
documentation that comes with the host bus adapter. The following considerations

apply:
» To use the dual-path configuration, perform the following tasks:
— Install two host adapters in each node.

— (Fibre Channel host bus adapters only) Connect two fiber-optic cables from
each node to the storage subsystem.
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» If you connect the storage subsystem through a Fibre Channel-Arbitrated Loop
(FC-AL), make sure that each adapter on the loop is assigned a unique hard ID.
For instructions about changing hard IDs, see the documentation that comes with
the host bus adapter.

» Make sure that the correct device driver is installed for the host adapter. See the
readme file in the \HostAdapter directory on the IBM System Storage DS3000
Support CD for information about supported host adapters and device drivers.

Storage subsystems

For specific hardware installation requirements and procedures, see the
documentation that comes with the hardware. If you are managing storage
subsystems directly, you must connect Ethernet cables to both controllers in each
storage subsystem.

Installing the Storport miniport host bus adapter device driver

An IBM Fibre Channel, iSCSI, or SAS host bus adapter provides the interface
between a host server and a DS3000 storage subsystem. IBM Fibre Channel,
iISCSI, and SAS host bus adapters are high-performance, direct memory access,
bus-master host adapters that are designed for high-end systems. The Fibre
Channel host bus adapters support all Fibre Channel peripheral devices that
support private-loop, direct-attach, and fabric-loop attachment. The IBM host bus
adapter device driver enables the operating system to communicate with the host
bus adapter.

The Storage Manager software provides the support of a Fibre Channel, iSCSI, or
SAS host bus adapter device driver that is based on the Microsoft Storport miniport
device-driver model. The Storport miniport device-driver model was introduced in
the Microsoft Windows Server 2003 release as a replacement for the SCSlport
miniport device driver model. It is the only supported device driver model for
Windows Server 2003 x64 editions, which support the AMD64 and EM64T servers.

To support Storport miniport device drivers, Service Pack 2 and the latest Storport
miniport hotfix must be installed in the Windows Server 2003 operating system. You
can download the latest Storport hotfix from |http://www.support.microsoft.com/kb/|
[032755/en-us] See the Storage Manager readme file for Microsoft Windows
operating systems for other requirements, such as controller firmware versions or
other Microsoft updates, and for information about the latest versions of the hotfix.

Installing the Storage Manager software in a Windows Server 2003 or
Windows Server 2008 cluster environment

To install the Storage Manager software and cluster service software on Windows
Server 2003 or Windows Server 2008, complete the following steps:

1. Make sure that the host bus adapter and device driver are installed in each
cluster node. For information about host bus adapter and device-driver
installation, see |“Installing the Storport miniport host bus adapter devicel

2. Install the Storage Manager software on the host server that will be the first
node of the cluster. For installation instructions, see [‘Installing the Storage|
[Manager host software packages” on page 34|

Note: Before you install the Storage Manager software on an existing storage
subsystem, see your hardware documentation for any specific
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configuration instructions. A specific configuration might be required for
the hardware to support the Storage Manager software in a cluster
configuration.

3. Complete the procedures in|Chapter 8, “Completing the Storage Manager|
|software installation and configuration,” on page 65,|specifically to create LUNs
that will be used as cluster disks and to make sure that the host type of the
host group or host ports that these LUNs are mapped to are set to Windows
2000/Server 2003 Clustered.

Note: You might have to restart the first node of the cluster to see the newly
added logical drives (LUNSs).

4. |Install the Storage Manager software on the second node of the cluster.

Note: You must install the MPIO and SMutil software packages. You do not
have to install all of the Storage Manager software packages unless you
want to manage the storage subsystem from this cluster node.

Repeat stepfor each additional node of the cluster.

5. Format all shared logical drives as New Technology File System (NTFS),
assign volume labels, and specify a drive letter for each.

Important: You must make sure that the permanent (sticky) drive letters that
are assigned to LUNs in the first cluster node are available (not
used) in the rest of the cluster nodes. All of the nodes in the
cluster must have the same drive letters on each shared drive. If
you do not assign permanent drive letters, Windows might assign
different drive letters on each node, which will prevent the cluster
disks from operating correctly. To make sure that Windows assigns
the same drive letter to the partition on all cluster nodes, assign a
permanent drive letter.

6. Install the cluster server software on the first node of the cluster. See the
applicable Microsoft Cluster Server (MSCS) documentation for the correct
procedure to install the cluster server software.

Important: During the installation of a Microsoft cluster solution, you must perform
the following steps on any additional node in the cluster:

a. Start the Cluster Administrator.
b. From the Cluster Administrator, click Join an existing cluster.

c. Enter the name of the cluster that was used in forming the cluster
on the node 1.

d. After you have established a connection to the cluster, click
Advanced on the Select Computer page.
e. Click Advanced (minimum) configuration.

7. Install the cluster server software on the second node of the cluster. See the
applicable MSCS documentation for the correct procedure to install additional
nodes in the cluster server.

Note: During installation, specify that you want to join the existing cluster. You
can add one cluster node at a time or all of the remaining cluster nodes
at the same time. You should add cluster nodes one at a time.

8. If all node names are not displayed on the left side of the Cluster Administrator
window, reinstall the cluster server software. If the problem remains, contact
your technical-support representative.
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9. In the Cluster Administrator window, make sure that all of the cluster disk
groups can be varied online and offline with no problems.

10. Manually move the cluster disk groups from the first cluster node to each of
the nodes in the cluster, making sure that they can be brought online. If they
can be brought online with no problems, you are ready to continue with the
application software installation. If you experience any problems, call your
technical-support representative.

Configuring storage management

After you install the Storage Manager software, complete the following tasks that
are described in [Chapter 8, “Completing the Storage Manager software installation|
land configuration,” on page 65.]

» Performing an initial automatic discovery of storage subsystems
» Adding storage subsystems

* Naming storage subsystems

» Configuring alerts

» Configuring host access

» Defining host groups

» Creating arrays and logical drives

* Managing iSCSI settings (DS3300 only)

* Downloading controller firmware and NVSRAM

Chapter 4. Installing the Storage Manager software in a Windows cluster server environment 43



44 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware



Chapter 5. Installing the Storage Manager software in a Linux
configuration

This chapter describes how to install the Storage Manager software in a Linux
operating system environment.

Note: This document does not provide information about using Linux on
POWER-based hosts.

Installation overview

Before you install the Storage Manager software, read the following information:

* Read the Storage Manager software readme file for your operating system before
you install the software. A readme file contains important information that was not
available when this document was prepared.

» Make sure that you have completed all preparation tasks described in [Chapter 2,
[‘Preparing for installation,” on page 21

* Make sure that the network components are set up and operating correctly.

* Make sure that you have the host and controller information that you need for the
software to operate.

Install the software on each host server in the following order:
1. Install the IBM host bus adapter device driver for Linux operating systems.
2. Install Linux MPP.

3. Install the Storage Manager 2 software according to the system type that you
want.

Note: For Storage Manager 2, the default installation directory for the host software
packages is /opt/IBM_DS3000.

Installing the IBM host bus adapter device driver

An IBM host bus adapter provides the interface between a host server and a
DS3000 storage subsystem. IBM DS3000 host bus adapters are high-performance,
direct memory access, bus-master host adapters that are designed for high-end
systems. The Fibre Channel host bus adapters support all Fibre Channel peripheral
devices that support private-loop, direct-attach, and fabric-loop attachment. The IBM
host bus adapter device driver enables the operating system to communicate with
the host bus adapter.

Install the host bus adapter device driver before you install the Storage Manager
software. See the readme file that is included in the device-driver package for
installation instructions for your operating system. For more information, see the
Installation and User’s Guide that comes with the host bus adapter.

The current readme file and latest IBM host bus adapter device drivers are
available for download at |http://www.ibm.com/servers/storage/support/disk/
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Storage Manager software for Linux

The DS3000 Storage Manager packages are available for two kernel versions of
Linux operating systems on the Support CD and at |http://www.ibm.com/servers/
istorage/support/| These packages are for servers with Intel and AMD architecture
x86 32-bit (IA-32) and x86 64-bit (AMD64 and EM64T) processors only.

The Storage Manager software packages contain the following components for
Linux:

» Storage Manager Runtime (SMruntime)
» Storage Manager Utility (SMutil)

« Storage Manager Client (SMclient)

e Linux MPP

Note: Linux MPP is provided as a separate package from the Storage Manager
software package for Linux. The Linux MPP installs the multipath proxy
(MPP) multipath driver for Linux. The Linux MPP is different from the
Storage Manager RDAC for Windows.

Install the Storage Manager Client (SMclient) component on the management
station. Installing SMclient on a host server is optional.

Install the following components only on the host:
» Storage Manager Utility (SMutil)

e Linux MPP

» Storage Manager Agent (SMagent)

Management station components

Install the following components on the management station. Installing these
components on a host server is optional.

+ Storage Manager Runtime (SMruntime)

This component is automatically installed with the Storage Manager Client. It
contains the Java™ runtime environment that is needed to run the other software
packages.

» Storage Manager Client (SMclient)

This component is needed if you want to manage the storage subsystem from a
host server or a management station.

Host components
Install the following components only on the host:
» Storage Manager Utility (SMutil)

This component is packaged with the SMclient package and contains the
hot_add and SMdevices utilities.

e Linux MPP
This component provides multipath failover/failback capability.

Note: Linux MPP is not packaged with the other software components in the
Storage Manager package for Linux operating systems. Also, there is a
different version of RDAC for each Linux kernel version, so check the
latest readme file to make sure that you have the correct version for your
Linux kernel.
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» Storage Manager Agent (SMagent)

This component is required if you want to use the host-agent (in-band)
management method for the DS3300 and DS3400 storage subsystem. You must
install Linux MPP before you install SMagent.

Notes:

1. In a Linux operating system environment, the preferred method for managing
DS3000 storage subsystems is the direct (out-of-band) method.

2. As of the date of this document, the DS3200 does not support in-band
management.

Installing the Storage Manager 2 software using the installation wizard

The DS3000 Storage Manager installation wizard is a Java-based interactive

method for you to choose the software packages that you want to be installed
automatically on the host system. The installation wizard installs the following
software packages on the Linux host:

* SMclient

* SMagent

e SMutil

Note: Before you install the Storage Manager software, make sure that a graphics
adapter is installed on the Linux host.

To install the Storage Manager software by using the installation wizard, complete
the following steps:

1. Make sure that you have root privileges, which are required to install the
software.

2. Insert the IBM System Storage DS3000 Support CD into the CD drive, and if
necessary, mount the CD drive.

3. Copy the SMIA-LINUXxxx host software installation package from the CD to a
directory on your system.

Note: The latest version of the Storage Manager host software packages are
available for download at http://www.ibm.com/servers/storage/support/].
4. Change to the directory in which you copied the SMIA-LINUXxxx package and
type the file name of the SMIA-LINUXxxx file in the following format to start the
Storage Manager installation wizard:

./SMIA-LINUXxxx-02.17 .xx.xx.bin

The Storage Manager installation wizard Introduction window opens.

5. Follow the instructions in each window of the wizard. When you select the

installation type, you can choose one of the following options (see
page 48):

« Typical (Full) Installation: Installs all Storage Manager software packages
* Management Station: Installs SMruntime and SMclient

* Host: Installs SMruntime, SMagent, and SMutil

« Custom: Enables you to select which packages you want to install
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Figure 9. Select Installation Type window

Note: The Storage Manager software packages are installed by default in the

/opt/IBM_DS3000 directory.

The Linux MPP package

Installation of the RDAC package is required only if the system is a host. You must
install RDAC on each host server. The RDAC package installs the multipath device
driver that is needed for controller failover support. A system restart is required
when you install the RDAC device driver package.

Notes:

1.

3.

You must install the host bus adapter device driver before you install RDAC. For
information about supported levels of host bus adapter device drivers, see the
Storage Manager 2 readme file.

Linux MPP is provided separately from the Storage Manager 2 host software
package. There are two Linux MPP packages, one for each type of kernel:

* 2.6 kernel (RHEL 4, SLES 9, and SLES 10) for RDAC Revision B
» 2.6 kernel (RHEL 5 and SLES 10 SP1) for RDAC Revision C

Be sure to install the correct Linux MPP for your system.

Important: Neither of the Linux MPP packages can be used for Linux on
POWER-based servers.

Always see the readme file that is included with the Linux MPP package for the
latest instructions for installing Linux MPP, including any dependencies or
limitations.
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4. This Linux MPP version does not support auto-volume transfer/auto-disk
transfer (AVT/ADT) mode. AVT/ADT is disabled by default so that the Linux
MPP can function correctly.

To unpack the Linux MPP source files from the directory in which you placed the
RDAC source .tgz file, at the command prompt, type the following command and
press Enter:

tar -zxvf filename.tar.gz
where filename is the name of the Linux MPP source file.

The source files are extracted into the yourdirectory/linuxrdac-version directory
(where version is the RDAC number; for example, linuxrdac-09.01.B5.39).

For detailed procedures for compiling and installing the device-driver modules, see
FInstalling Linux MPP.]

Installing Linux MPP

The Linux MPP provides multipath failover/failback support for the logical drives in
the DS3000 storage subsystem that are mapped to the Linux host server. The Linux
host server must have I/0O (depending on the host bus adapter type) connections to
the host ports of both controllers A and B of the DS3000 storage subsystem (if you
have a dual-controller configuration).

For the latest related dependencies, see the Storage Manager readme file. The
readme file is available on the Support CD and at |http://www.ibm.com/servers/|
istorage/support/disk/

For the latest supported DS3000 storage subsystem models, host bus adapters,
device drivers, Linux kernel versions and updated readme, see
Ihttp://www.ibm.com/servers/storage/support/disk/|

Note: Deviations from the listed code levels are not supported. For more
information, contact your technical-support representative.

Limitations

* The Linux SCSI layer does not support skipped (sparse) LUNs. If the mapped
LUNSs are not contiguous, the Linux kernel will not scan the remaining LUNSs.
Therefore, LUNs following the skipped LUN will not be available to the host
server. Always map LUNs by using consecutive LUN numbers.

» If a host server with Fibre Channel host bus adapters has multiple host bus
adapter ports and each port sees both controllers (over an unzoned switch), the
Linux MPP driver might return 1/O errors during controller failover. In this case,
use multiple unconnected Fibre Channel switches to zone the Fibre Channel
switch into multiple zones so that each host bus adapter port sees only one
controller in a DS3000 storage subsystem.

* It is not possible to load the virtual host bus adapter device driver if no storage
subsystem is attached. The workaround for this inability is to connect the host
server to the DS3000 storage subsystem and run the hot_add utility.

Note: If no LUN is mapped to the host server partition on the DS3000 storage
subsystem, the hot_add utility will not bring up the mpp_Vhba module.
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* The Linux MPP driver does not support LUN deletion. You must restart the server
after you delete mapped logical drives.

* Do not load or unload the RDAC driver stack, which includes the mpp_Upper and
mpp_Vhba tools, and the low level host bus adapter device driver, by using the
modprobe kernel module utility. Any use of modprobe on the RDAC driver stack
is the responsibility of the user. IBM does not support the use of modprobe with
the RDAC driver stack. Use of rmmod to remove all the drivers in the RDAC
driver stack, in order, is also not supported. Whenever you must unload the
driver stack, restart the system.

Prerequisites

* The Linux MPP driver is released as a source-code package in the format of a
gunzip compressed tar file. To unpack the driver source package, type the
following command in the Linux console window: tar -zxvf
rdac-LINUX-xx.xx.xx.xx-source.tar.gz, where xx.xx.xx.xx is the release version
of the RDAC driver. The source files are extracted into the linuxrdac-version
directory (where version is the RDAC number; for example, linuxrdac-
09.01.B5.39).

» Build and install the host bus adapter device driver on the host server before you
install the Linux MPP driver. See the host bus adapter device driver readme file
or the host bus adapter Installation and User's Guide for instructions for installing
the device driver. If you have to build the host bus adapter device driver from the
source tree, the device driver source tree is included in the source-code
package. This device driver must be loaded before the RDAC installation.

* The host server can have different host bus adapters from multiple vendors or
different host bus adapter models from the same vendors; however, only one
model of the host bus adapter can be connected to the DS3000 storage
subsystems.

* Make sure that you install the kernel source tree against which to build the Linux
kernel version before you install the RDAC driver package.

For the SUSE Linux Enterprise Server 9 distribution only

To install and set up the Linux MPP for a SUSE Linux Enterprise Server 9
environment, complete the following steps:

1. Install the kernel-source from the SUSE distribution.
2. Create a soft link to the kernel source by typing the following command:
Tn -sf /usr/src/linux-version /usr/src/Tinux

3. To make sure that the kernel version is synchronized between the device driver
and the running kernel, type the following commands in the Linux console
window. Press Enter after you type each command:

e cd /usr/src/linux

* make mrproper (completely clean the kernel tree)

e - cp /boot/config-"uname -r~ .config (copy the new configuration file)
» make oldconfig (update configuration using the .config file)

* make dep (rebuild the dependencies)

* make modules (build the modules) (not required on newer kernel versions)

Building the RDAC driver for SUSE Linux and Red Hat Linux

1. Change to the linuxrdac directory.

2. To remove the old driver modules in that directory, type the following command
and press Enter:
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make clean

To compile all driver modules and utilities in a server with multiple processors
(SMP kernel), type the following command and press Enter:

make

Installing the RDAC driver

1.

To copy driver modules to the kernel module tree and build the new RAMdisk
image (mpp.img), which includes RDAC driver modules and all driver modules
that are needed during boot time, type make install and press Enter.

Follow the instructions that are displayed at the end of the build process to add
a new boot menu option, which uses /boot/mpp-kernel version.img as the initial
RAMdisk image.

Near the end of the Linux MPP installation, if you see the error message Al1 of
your Tloopback devices are in use, and the RDAC RAMdisk is not created,
and the installation fails, type the following commands in the Linux console
window:

insmod Toop (This command loads the loopback device driver onto the kernel.)

make uninstall (This command uninstalls the previous, unsuccessful RDAC
driver.)

make install (This command installs the RDAC driver again.)

The following instructions might work in certain Red Hat kernel versions. Add
ramdisk_size=15000 as a kernel boot parameter in the new boot option, similar to
the following grub.conf example.

Note: The actual text might be different, depending on the system setup

configuration.

title Red Hat Linux Advanced Server-up (2.4.9-e.27smp)

root (hd0,6)

kernel /vmlinuz-2.4.9-e.27smp ro root=/dev/hda7 ramdisk_size=15000
initrd /mpp-<kernel version>.img

RDAC driver post-installation

1.

Restart the system by using the New Boot Menu option.

2. Type Tsmod to make sure that the driver stack is installed correctly.

Note: On Red Hat distributions, the following modules should be installed:
scsi_mod, sd_mod, sg, mpp_Upper, mpp_Vhba(*), and host bus adapter
device drivers. On SUSE Linux distributions, the following modules
should be installed: sg, mpp_Upper, mpp_Vhba(*), and host bus adapter
device drivers.

To make sure that the RDAC driver discovered the available physical LUNs and
created virtual LUNs for them, type 1s -1R /proc/mpp and press Enter.

You can now issue 1/Os to the LUNSs.

If you make any changes to the MPP configuration file (/etc/mpp.conf) or the
/var/mpp/devicemapping persistent binding file, run mppUpdate to rebuild the
RAMdisk image and to include the new file so that the new configuration file (or
persistent binding file) can be used on any subsequent system restart.

To capture all debug and error messages for the MPP driver, the /etc/syslog.conf
file must have entries for kern.debug, kern.notice, kern.info, and kern.warning.
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Proc entries

To make sure that the RDAC driver discovered the available physical LUNs and
created virtual LUNs for them, type 1s -1R /proc/mpp and press Enter.

The Linux operating system provides a /proc file system that is a special
memory-only, software-created file system that is used by the kernel to export
device-driver information to the user space.

The proc pseudo-filesystem is mounted to /proc. The Linux SCSI subsystem proc
file system directory is /proc/scsi. By convention, each host bus adapter device
driver creates a subdirectory under /proc/scsi.

The Linux MPP driver proc entries are as follows:
e /proc/mpp

Entry for the MPP driver.
 /proc/scsi/mpp/adapter_number

Entry for the MPP virtual host adapter. This can differ from system to system and
is assigned by the SCSI middle layer.

* /proc/mpp/storage_sys_name
Entry for each subsystem that is visible to the host.
* /proc/mpp/storage_sys_name/controllerA/B

Entries for the two targets on each subsystem as seen by the host. Each storage
subsystem has two controllers.

» /proc/mpp/storage_sys_namel/controllerA/Bl/low_level_driver/ HCT#

The low_level_driver can be any one of QLogic, Emulex, LSI Logic host bus
adapters, or iISCSI software initiators. HCT# can be the Host# (host number of
the low-level driver that is assigned by the SCSI middle layer), Channel#
(depending on whether the host bus adapter is a single-port or dual-port), or
Target# (target number that is assigned to that controller on that subsystem by
the low-level host bus adapter device driver).

» /proc/mpp/storage_sys_name/controllerA/Bl/low_level_driver
The logical drives or LUN numbers of logical drives, as mapped on the host
partition on the storage subsystem and seen through that path, or initiator
(host)-target combination.

Persistent naming

Linux SCSI device names might change when the host system restarts. The
preferred method is to use a utility, such as devlabel, to create user-defined device
names that will map devices according to a unique identifier, called a UUID.

Uninstalling and reinstalling (updating) the RDAC driver package

To uninstall the RDAC driver package, type make uninstall and press Enter.

Note: To reinstall or update the RDAC driver package, type make uninstall, and
then type make install under the /linuxrdac directory in the new RDAC
driver source code bundle.

Kernel update

After you apply the kernel update and boot into the new kernel, to build the MPP
Initrd image for the new kernel, complete the following steps:

1. Change the directory to the Linuxrdac source code directory.
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2. Type the make uninstall command.

3. Follow the driver building and installation procedure that is described in
“Building the RDAC driver for SUSE Linux and Red Hat Linux” on page 50| and
“Installing the RDAC driver” on page 51

Initial RAMdisk image (initrd)
The Initial RAMdisk Image (initrd image) is automatically created when you install
the driver by typing the make install command. The boot loader configuration file
must have an entry for this newly created image.

The initrd image is in the boot partition with the mpp-uname-r.img file name (for
example, mpp-2.4.21-9.ELsmp.img).

For a driver update, if the system already has an earlier entry for MPP, the system
administrator must modify only the existing MPP entry accordingly in the boot
loader configuration file. In most cases, no change is required if the kernel version
is the same.

To create a new initrd image, type mppUpdate, which overwrites the earlier image file
with the new image file.

If you have to add third-party drivers to the initrd image, edit the
/etc/sysconfig/kernel file (SUSE Linux) or the /etc/modules.conf file (Red Hat Linux)
with the independent software vendor party driver entries. Run mppUpdate to create
a new RAMdisk image.

Adding and deleting mapped logical drives (LUNS)

Linux MPP supports the rescanning of a newly mapped LUN without restarting the
server. The utility program is packaged with the Linux MPP driver. You can start it
by entering either the hot_add or mppBusRescan command. The hot_add
command is a symbolic link to mppBusRescan. There are man pages for both
commands.

The Linux MPP driver does not support LUN deletion. After you delete mapped
logical drives, you must restart the server.

Removing the temporary installation files

To remove the temporary installation files from the temporary directory, use one of

the following methods:

* Restart the host. All of the entries in the /tmp file system are deleted when the
host is restarted.

* Type the following commands:

cd /tmp
cd installation_directory_name
m *.% -r

Uninstalling the Storage Manager software

The procedure in this section is for uninstalling an earlier version of the Storage
Manager software from one or more Linux management stations or hosts.

Note: You do not have to restart the host server after you remove a software
component. During the software removal process, the host keeps the
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existing storage subsystem mappings and storage partition configurations,
which the new client software recognizes.

The DS3000 Storage Manager installation wizard creates an Uninstall directory in
the directory in which you installed the Storage Manager host software. The default
file name for this directory is /opt/IBM_DS3000. The directory contains a file named
Uninstall_IBM_DS3000. To uninstall the host software, change to this directory and
type the following command:

# sh ./Uninstall_IBM_DS3000

When the wizard opens, follow the instructions.

Configuring storage management

After you install the Storage Manager software, complete the following tasks that
are described in [Chapter 8, “Completing the Storage Manager software installation|

tand configuration,” on page 65.]

Performing an initial automatic discovery of storage subsystems
Adding storage subsystems

Naming storage subsystems

Configuring alerts

Configuring host access

Defining host groups

Creating arrays and logical drives

Managing iSCSI settings (DS3300 only)

Downloading controller firmware and NVSRAM
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Chapter 6. Installing the Storage Manager software in a
standard NetWare configuration

This chapter describes how to install the Storage Manager software in a Novell
NetWare operating system environment.

Notes:

1. As of the date of this document, the DS3300 storage subsystem does not
support the Novell NetWare operating system.

2. The storage subsystem controller firmware supports a DS3000 storage
subsystem connection to a NetWare host; however, as of the date of this
document, the Storage Manager software is not supported on NetWare
management stations.

To manage a DS3000 storage subsystem that is connected to a NetWare host
server, you must install the Windows or Linux version of the Storage Manager
SMclient program on a management station and make an out-of-band management
connection to the DS3000 storage subsystem. For more information about how to
install the Storage Manager Client program on a Windows management station, see
Chapter 3, “Installing the Storage Manager software in a standard Windows|
configuration,” on page 31| or [Chapter 5, “Installing the Storage Manager software iri
@ Linux configuration,” on page 45.|

This chapter describes how to install the host bus adapter device driver, the
LSIMPE.cdm driver, and the NetWare native failover device driver. For correct
installation, complete all preparation tasks that are described in
Preparing for installation,” on page 21.|

Important: Always check the Storage Manager software readme file for your
operating system before you install the software. A readme file contains
important information that was not available as of the date of this
document.

Installing the IBM host bus adapter device driver

An IBM host bus adapter provides the interface between a host server and a
DS3000 storage subsystem. IBM host bus adapters are high-performance, direct
memory access, bus-master host adapters that are designed for high-end systems.
The IBM Fibre Channel host bus adapters support all IBM Fibre Channel peripheral
devices that support private-loop, direct-attach, and fabric-loop attachment. The IBM
Fibre Channel, iSCSI, and SAS host bus adapter device drivers enable the
operating system to communicate with the host bus adapter.

See the readme file that is included in the device driver package for installation

instructions for your operating system. For more information, see the Installation
and User’s Guide that comes with the host bus adapter.
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Installing the LSIMPE device driver and NetWare native failover device
driver

The NetWare native failover device drivers are the only supported failover device
drivers for the Novell NetWare operating system environment. The NetWare native
failover device drivers (MM.NLM and NWPA.NLM) are installed by default with
NetWare 6.5.

Important:

1. Always use the Novell NetWare native failover device driver in the latest support
pack for a particular NetWare operating system version. Also, use the latest
version of the LSIMPE.CDM file from either the latest Novell Support Pack or
the version that is included with the IBM host bus adapter device driver for
NetWare, which is available at the IBM DS3000 support Web site.

2. For the latest instructions about failover/failback configuration and setup, see
the Storage Manager readme file.

The LSIMPE.CDM device driver is used in a Novell NetWare environment to enable
the Novell native multipath device driver to recognize the NetWare host-mapped
logical drives that are created on DS3000 storage subsystems. The LSIMPE.cdm
device driver is a custom driver module that is packaged with the IBM DS3000 host
bus adapter device driver and the Novell operating-system distribution CD.

See the IBM host bus adapter device-driver readme file for the current LSIMPE.cdm
device driver. You can find the latest readme file at |http://www.ibm.com/servers/|
istorage/support/disk/

Note: The embedded Isimpe.cdm device driver for Novell NetWare 6.5 Service
Pack 7 does not function with the DS3000 controllers. For failover to work
correctly, you must use the files from |http:/support.novell.com/docs/
[Readmes/InfoDocument/patchbuilder/readme_5006860.html|
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Chapter 7. Using a DS3000 storage subsystem with a VMware
ESX Server configuration

Important: The DS3000 Storage Manager software is not available for VMware
ESX Server operating systems as of the date of this document.
Therefore, to manage DS3000 storage subsystems with a VMware ESX
Server host, you must install the Storage Manager Client software
(SMclient) on a Windows or Linux management workstation. (This can
be the same workstation that you use for the Web-based VMware
Management Interface.)

For instructions for installing the DS3000 Storage Manager 2 Client software
(SMclient) on a Windows or Linux management station, see [Chapter 3, “Installing
the Storage Manager software in a standard Windows configuration,” on page 31| or
Chapter 5, “Installing the Storage Manager software in a Linux configuration,” on|

page 45.|

For more information about using a DS3000 storage subsystem with a VMware
ESX Server host, see the Storage Manager software readme file.

Sample configuration
shows a sample VMware ESX Server configuration.

Ethernet

Management station ESX server

<4+—1/O path

Ethernet —»

‘ Controller ‘

‘ Controller ‘

Storage subsystems

Figure 10. Example of a VMware ESX Server configuration

Software requirements

This section describes the software that is required to use a VMware ESX Server
host operating system with a DS3000 storage subsystem.

© Copyright IBM Corp. 2006, 2008 57



Management station
The following software is required for the Windows or Linux management station:
1. SMruntime (Linux only)
2. SMclient (Windows and Linux)

Note: The mapping storage partition host type for VMware is Inxclvmware.

Host (VMware ESX Server)

The following software is required for the ESX Server:

VMware ESX Server 2.5.4, VMware ESX Server 3.0.1, VMware ESX Server 3.0.2,
VMware ESX Server 3.5, VMware ESX Server 3.5.1, and VMware ESX Server
3.5.2

For VMware ESX Server restrictions, see the Storage Manager software readme
file.

Notes:

1. Use VMware Tools for guest operating system software.

2. The DS3200 storage subsystem is supported on VMware ESX Server 3.5.1 or
later.

3. The DS3300 storage subsystem is supported on VMware ESX Server 3.5 or
later.

Clustering

For information about Windows clustering with VMware ESX Server, see the ESX
Server Installation Guide at |http://www.vmware.com/support/pubs/.

Configuring storage subsystems

Before you can configure storage subsystems, you must physically configure the
host server, SAN fabric, and DS3000 controllers (no SAN fabric is required with the
DS3200), assign initial IP addresses to the controllers, and install SMclient on the
Windows or Linux management station. These procedures are described in this
document in the following sections.

Setting up the VMware ESX Server host
For more information about setting up the VMware ESX Server host, see the
documentation and readme files at |http://www.vmware.com/support/pubs/}

For information about installing a VMware ESX Server operating system on an IBM
server, see |http://www.ibom.com/systems/support/}

Setting up the SAN fabric
For information about setting up the SAN fabric, including information about zoning,
see |http://www.vmware.com/support/pubs/|

Assigning initial IP addresses
For information about assigning initial IP addresses to the DS3000 controllers, see
|“Step 3: Assigning IP addresses to hosts and controllers” on page 25.|

Installing SMclient on a Windows or Linux management station

For information about installing SMclient on a Windows management station, see
Chapter 3, “Installing the Storage Manager software in a standard Windows|
configuration,” on page 31
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For information about installing SMclient on a Linux management station, see
Chapter 5, “Installing the Storage Manager software in a Linux configuration,” on|

page 45.|

Completing storage management installation and configuration

For information about completing storage management installation and configuration
tasks, see|Chapter 8, “Completing the Storage Manager software installation andl
lconfiguration,” on page 65|

Mapping LUNs to a storage partition

This section contains notes about LUN mapping that are specific to VMware ESX
servers. For the procedures that describe how to map the LUNs to a partition, see
Mapping LUNSs to a partition” on page 77

When you map LUNs on VMware, note the following information:
* On each partition, you must map a LUN 0.

« Always map the LUNs using consecutive numbers, starting with LUN 0. For
example, map LUNs to numbers 0, 1, 2, 3, 4, 5, and so on, without skipping any
numbers.

* LUN sharing across multiple ESX servers is supported only when you are
configuring VMotion enabled hosts. On LUNs that are mapped to multiple ESX
Servers, you must change the access mode to Shared. You can map the LUNS
to a host group for the ESX servers, so that they will be available to all members
of the host group. For more information about Windows Clustering with ESX
Server, see the ESX Server Installation Guide at [http://www.vmware.com/support/

VMware failover setup instructions

The only supported failover mechanism that you can use with a DS3200 or DS3400
storage subsystem that is attached to a VMware host is the MRU (most recently
used).

Note: The default failover that is selected when you create new VMware guest
operating system partitions is MRU, so no changes are required.

The MRU failover mechanism enables path failover and path recovery, but no
automatic failback.

To rebalance your LUNs, complete the following steps:

1. Select the Storage Manager 2 software and open the Subsystem Management
window.

2. Click the Support tab.
3. Select Manage Controllers, and then select Redistribute Logical Drives.

If you select Fixed for the failover mechanism, you cannot failback to the
preferred path. Any subsequent failure that occurs after the initial problem will
cause you to lose access to the logical drives assigned to the non-preferred
path.
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VMware iSCSI Software Initiator Configuration instructions

To configure a VMware iSCSI Software Initiator, complete the following steps:
1. Create a VMkernel port for the software initiator.

2. Create a virtual switch, and then select the network adapter that the virtual
switch uses.

3. Enter the IP address and subnet mask for the IP settings.

When you set up target discovery addresses for the software initiator, use an
address from each network, if multiple networks are being used.

The following illustration shows a sample configuration in which both VNIC 0 and
VNIC 1 are assigned to the same virtual switch (Virtual switch 0). This configuration
enables all the ports on the DS3300 to be accessed by the host.

Host
Virtual switch 0 - 1.0.0.1
Port0-1.0.0.2
Port1-1.0.0.3 Virtual switch 0 Virtual switch 0
Port2-1.0.0.4 VNIC 0 VNIC 0
Port 3-1.0.0.5
Ethernet switch

ATt
NENEREREREREAEn

D

DS3300
Port0  Port 1 Port2 Port 3

Figure 11. Sample configuration showing VNIC 0 and VNIC 1 assigned to the same virtual
switch
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The following illustration shows a sample configuration in which VNIC 0 and VNIC 1
are assigned to different networks. The ports on the DS3300 must be assigned IP
addresses so that at least one port from each controller on the DS3300 is
accessible to each network.

Host
Virtual switch 0 - 1.0.0.1
Virtual switch 1 - 2.0.0.1
Port 0-1.0.0.2
Port 1-2.0.0.2 Virtual switch 0 Virtual switch 1
Port2-1.0.0.3 VNIC 0 VNIC 1
Port 3-2.0.0.3

Ethernet switch

HEEREENREENREEN
NENERERE RSN

DI

DS3300
Port0  Port 1 Port2 Port 3

Figure 12. Sample configuration showing VNIC 0 and VNIC 1 assigned to different networks

For more information about setting up the iISCSI software initiator, see
lhttp://www.vmware.com/pdf/vi3_35/esx_3/r35/vi3_35_25_iscsi_san_cfg.pdf,

Configuring SAS HBA BIOS timeout settings for correct failover

To make sure that the DS3200 storage subsystem provides correct path failover
during heavy I/0 in a VMware environment, you must reconfigure two timeout
values in the BIOS of the SAS HBA. Failure to reconfigure two timeout values in the
BIOS of the SAS HBA can cause /O timeouts. The values that you must change
are Report Device Missing Delay and I/O Device Missing Delay.

To change the SAS HBA BIOS timeout settings, complete the following steps:
1. Restart the host with the SAS HBAs.

2. When you are prompted during POST, press Ctrl+C to start the LSI Corp (SAS)
Configuration Utility.

Note: If you experience PCI Resource Allocation Errors that prohibit the
configuration utility from initializing, you might be forced to disable some
PCI devices or control the ROM execution space. This error message
indicates that the system ROM space is full and there is no more room
for additional adapters that use ROM space. For more information, see
the Retain Tips for “1801 PCI Allocation Errors” at |http://www.ibm.com/|
[systems/support/}

3. On the Adapter List screen, use the arrow keys to select a SAS HBA, and then
press Enter. The Adapter Properties screen is displayed.

4. Select Advanced Adapter Properties and press Enter.
5. Select Adapter Timing Properties and press Enter.
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6.

7.

8.

Change the Report Device Missing Delay to 10 seconds by pressing the +
key, - key, or Spacebar.

Change the 10 Device Missing Delay to O seconds by pressing the + key, -
key, or Spacebar.

Note: For VMware ESX Server 3.5.2, change the Report Device Missing
Delay to 144 seconds and change the 10 Device Missing Delay to 8
seconds.

Repeat step |3 on page 61|through stepEIfor each SAS HBA in the host

servers.

Configuring DS3000 storage subsystem controller sense data for
VMware Windows guest operating systems

You can configure the DS3000 storage subsystem controllers to return either the
Unit Attention or Not Ready message when quiescent. A DS3000 controller that is
running Windows as a guest operating system returns Not Ready sense data when
it is quiescent. Returning Unit Attention sense data might cause the Windows guest
operating system to fail during a failover operation.

Note: As an alternative to using the command shell as described in the following

procedure, you can use the Script Editor in the DS3000 Storage Manager
software.

To configure the DS3000 controllers to return Not Ready sense data, complete the
following steps:

1.
2.

3.

Change to the directory path where the SMcli executable file is located.

In a shell window of the management station, type the following command to
determine the index for the VMLNXCL host type:

SMcli ip_addr_for_controllerA ip_addr_for controllerB
-c "show storagesubsystem hosttopology";

Press Enter.

Type the following commands to enable controller A to return Not Ready sense
data. Press Enter only after you enter all of the commands.

Notes:

* In the following commands, the value 13 is used for the index that
corresponds to VMLNXCL in the NVSRAM host type definitions returned by
this command. If your controllers use a different value for the index for
VMLNXCL, substitute that index value for 13 in the following commands.

* The following commands reset the controller. The controller is temporally
unavailable until the controller reset operation is completed.

SMc1i ip_addr_for_controllerA ip_addr_for_controllerB

-c "set controller [a] hostNVSRAMBYTE [13,0x12]=0x01;

set controller [a] hostNVSRAMBYTE [13,0x13]=0x00;

reset Controller [a]";

Before proceeding to the next step, wait until controller A has finished restarting

and the storage subsystem status is Optimal.
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4. Type the following commands to enable controller b to return Not Ready sense
data. Press Enter only after you enter all of the commands.

Note: The following commands reset the controller. The controller is temporally
unavailable until the controller reset operation is completed.

SMc1i ip_addr_for_controllerA ip_addr_for _controllerB
-c "set controller [b] hostNVSRAMBYTE [13,0x12]=0x01;
set controller [b] hostNVSRAMBYTE [13,0x13]=0x00;
reset Controller [b]";

Required update for VMware

The Red Hat Enterprise Linux 5 guest operating system file systems might become
read-only in the event of a lot of I/O retries or path failover of the ESX Server host
storage. For more information, see |http://kb.vmware.com/selfservice/micrositeS/|
lsearch.do?language=en_US&cmd=displayKC&externalld=1001778|
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Chapter 8. Completing the Storage Manager software
installation and configuration

This chapter contains information about using the Enterprise Management and
Subsystem Management features of the Storage Manager 2 software to complete
the installation tasks for the Windows, Linux, and NetWare operating system
environments.

Note: As of the date of this document, the DS3000 Storage Manager 2 software is
not available for NetWare operating systems. To configure the Storage
Manager 2 software with your NetWare host, complete the tasks in this
section by using SMclient on a Windows or Linux management station.

To complete the Storage Manager 2 software installation, perform the following
tasks. Each of these tasks is discussed in detail in the following sections.

Perform a discovery of storage subsystems.
Add devices, if necessary.

Set up alert notifications, if you want to.
Name the storage subsystems.

Download firmware and NVSRAM.

Create arrays and logical drives.

Configure the heterogeneous hosts.

Map logical drives to a partition.

Perform other storage subsystem tasks.

© © N Ok D~

Starting the Storage Manager software and discovering storage
subsystems

To start the Storage Manager software and discover storage subsystems, complete
the following steps:

1. Choose one of the following commands:
* For Windows: Click Start » Programs » Storage Manager 2 Client.
» For Linux: Enter /opt/IBM_DS3000/client/SMclient (by default).

The client software starts and the Enterprise Management window opens. Then,
the Task Assistant window (shown in|Figure 15 on page 69) and the Select
Addition Method window (shown in [Figure 13 on page 66) open on top of the
Enterprise Management window.
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l ikil Select Addition Method

Your matagernent domain is not configured to monitor or manage any storage
zubsystems. Choose a method for the addition of storage subsystems:

f* ftomatics

Dizcovers storage subsystems automatically within the local sub-network.
| The dizcovery process may take several minutes o complete.

 manual:

Add storage subsystems by host or cortroller IP address or host name. This
option iz typically uzed only to add a storage subsystem that iz outside the
local sub-netvwork.

Cancel | Help |

Figure 13. Select Addition Method window

2. Select Automatic to discover all hosts and storage subsystems that are
attached to the local subnetwork. Select Manual to specify the IP address of a
device that is attached to the local subnetwork.

Note: The Enterprise Management window can take up to 1 minute to refresh
after an initial automatic discovery.

3. Make sure that each host and storage subsystem is displayed in the Enterprise
Manager window.

If a host or storage subsystem is not displayed, complete the following tasks:

* Check the hardware and hardware connections for possible problems (see
the hardware documentation for specific procedures).

* For more information about discovering storage subsystems, see the
Enterprise Management online help.

» If you are using the direct-management method, make sure that all hosts and
storage subsystems are connected to the same subnet network. If you are
using the host-agent method, make sure that the 1/0 connection between the
host and the storage subsystem is made.

* Make sure that all of the preparation steps for setting up the storage
subsystem for a direct-managed system in|[Chapter 2, “Preparing for]
installation,” on page 21| are completed. If they are, use the Add Device
option to add the IP addresses of the storage subsystem. Add both IP
addresses of the controllers. Otherwise, a partially-managed device error
message is displayed when you try to manage the storage subsystem.
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* If you are using the host-agent management method, complete the following

steps:
a. Make sure that the SMagent is installed on the host.

b. Make sure that you have a valid I/O connection from the storage
subsystems to the host in which the SMagent is installed.

c. Make sure that all of the preparation steps that are outlined in|Chapter 2,
|“Preparing for installation,” on page 21| are complete. If they are, complete

the following steps:
1) Run the hot_add utility.

2) Restart the SMagent, using the information in|“Stopping and restartind

the host-agent software” on page 99|

3) On the Enterprise Management window, click the host and
click Tools » Rescan.

Note: In certain situations, a storage subsystem might be duplicated in the
device tree after an automatic discovery. You can remove a duplicate
storage management icon from the device tree by using the Remove
Device option in the Enterprise Management window.

4. Make sure that the status of each storage subsystem is Optimal. If a device
shows a status of Unresponsive, right-click the device and select Remove
Device to delete it from the management domain. Then, use the Add Device

option to add it to the management domain again. For instructions for removing

and adding devices, see the Enterprise Management window online help.

shows the Enterprise Management window after an initial automatic
discovery.

l:iiIBM Sysem Sturge D53l] Sturag Manager 2 (Enterprise Management} i = IEIIﬂ

| Edit “iew Tools Help %
A @UE i A

= I Iame I Typel Statuz Metwork Management Type I Comment I

B {-Band Storage Subsystems [SCSI2-MS-S0y ) optimal Out-of-Band

) storage Subsystem ISCEI2-MS-SW sesi-alel BH © optimal Out-of-Band

O storage Subsystem 5CEH OLET scan-linnx B & Optimal Out-of-Band
far-iscsi Optimsl Out-of-Band

@Storage Subzystem ISCSI5-Linux arisest @ @ e at-=an

@Storage Subzystem far-iscsi

@ I IAutomat\c discovery campleted. Found 4 host(s) andior storage subsystem(s).

Figure 14. Enterprise Management window
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Using the Task Assistant

When you start the Storage Manager software, the client software starts, and the
Enterprise Management window opens. Then, the Task Assistant window opens and
provides a central location from which you can choose to perform the most common
tasks.

Note: The Task Assistant window opens automatically each time you open the
Enterprise Management window, unless you select the Don’t show the task
assistant at start-up again check box at the bottom of the window.

The Task Assistant provides shortcuts to the following tasks:
» Adding storage subsystems

* Naming or renaming storage subsystems

» Configuring alerts

* Managing storage subsystems

[Figure 15 on page 69| shows the Enterprise Management Window Task Assistant.
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il Enterprise Management Window Task Assistant

What are the Enterprize and Subsystetn Management Windows'?

Which Task Would You Like To Perform?
The Taszk Assistant helps you complete tasks guickly and easily within the Enterprize Management
Windowy. Please choose atask:

Initial Setup:

Add Storage Subsystems
You must add a storage subsystem to the management domain befare it can be
configured ar managed.

MamefRename Storage Subsystems
Marnitig & storage subsystem and providing a comiment makes it easy to find the
array within the management domain or determine itz physical location.

Configure Aletts
Iﬁ h Configuring aletts alloves you to receive email or =MMP nhotification whenever
|1L| U | there are critical problems on & storage subsysten.

Subsystem Management:

Manace a Storage Subsystem
Launch the Subsystem Management YWindowe to perform configuration tasks Sjll
»

e R s N S e e g e R e e iy e G G 2 _..|._.._1_1.. o

K

{1 Don't showe the task assistant &t start-up again
Mote: To dizplay the Tazsk Assistant again, zelect YWiew == Tazk Azsistant.

Figure 15. Enterprise Management Window Task Assistant

To open the Task Assistant after you have started the Storage Manager software,
click View » Task Assistant from the Enterprise Management window, or on the

toolbar, click the Task Assistant icon .

Adding storage subsystems

To manually add more hosts or storage subsystems, from the Enterprise
Management window, click Edit » Add Storage Subsystem. You can use this
option to selectively manage a group of storage subsystems from a Storage
Manager Client, and you can add devices that are to be managed and were not
discovered during the initial discovery. For more information, see the Enterprise
Management window online help.

Important:

* When you add an unidentified device, a window opens confirming that the device
was successfully added and that you can manage the storage subsystem. Any
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device that is listed in the unidentified device group will not be able to be
managed until it is discovered correctly. Make sure that the connections are
made, and try to add the device again.

* When you add new storage subsystems to the existing storage subsystems in a
SAN that are managed through the host-agent software, you must stop and
restart the host-agent service. When the host-agent service restarts, the new
storage subsystem is detected. For more information, see
|restarting the host-agent software” on page 99.| Then, go to the Enterprise
Management window and click Tools » Rescan to add the new storage
subsystems to the management domain.

* When you add new storage subsystems to existing storage subsystems that are
managed through the direct (out-of-band) management method, be sure to
specify the IP addresses for both controllers.

Naming storage subsystems

To name your storage subsystem, complete the following steps:

1. In the Enterprise Management window, select a storage subsystem, right-click
the storage subsystem and select Rename. The Rename Storage Subsystem
window opens.

‘ =101 ]
Edit  Yiew Tools Help %
A QB BBl A
EI—34Bboﬂom Marme ITypeI Status Metwark Management Type I Comment |

IJ:'|—Ou1-Uf-Eiand Storage Subsystems FLLL % @ Optirnal Cut-of-Band
yatem FULL

iil Rename Storage Subsystem

Storage Subsystem name (max 30 characters]

ke I Cancel | Help |

[} I |Automatic discovery completed. Found 1 host{s) and/or storage subsystem(s).

Figure 16. Rename Storage Subsystem window

2. Type the name of the storage subsystem (see [Table 12 on page 105). Then,
click OK. A warning message is displayed stating that changing the storage
subsystem name can cause host applications to lose access to the storage
subsystem. Click Yes to continue or No to cancel naming the storage
subsystem.

3. Repeat this procedure for each unnamed storage subsystem. For more
information, see the topic about renaming storage subsystems in the Subsystem
Management window online help.
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Configuring alerts

After you add devices to the management domain, you can set up alert notifications
to report critical events on the storage subsystems. The following alert-notification
options are available:

» Notification to a designated network management station (NMS) through Simple
Network Management Protocol (SNMP) traps

* Notification to designated e-mail addresses

Note: You can monitor storage subsystems only within the management domain. If
you do not install the Event Monitor service, the Enterprise Management
window must remain open. If you close the window, you will not receive any
alert notifications from the managed storage subsystems. For more
information, see the Enterprise Management window online help.

To set up alert notification, from the Enterprise Management window, click Edit -
Configure Alerts.

To set up alert notification to a network management station (NMS) by using SNMP
traps, complete the following steps:

1. Insert the IBM System Storage DS3000 Support CD into the CD drive on an
NMS. You must set up the designated management station only once.

2. Copy the SM2.MIB file from the SM2MIB directory to the NMS.

3. Follow the steps that are required by your NMS to compile the management
information base (MIB) file. For more information, contact your network
administrator or see the documentation that comes with your
storage-management software.

The Initial Setup Tasks window
From the Subsystem Management window, you can open the Initial Setup Tasks
window, which contains links to the following tasks:
» Locating the storage subsystem
* Renaming the storage subsystem
» Setting the storage subsystem password
» Configuring host access
* Managing iSCSI settings (DS3300 only)
» Configuring the storage subsystem

To open the Initial Setup Tasks window, complete the following steps:

1. In the Enterprise Management window, double-click the storage subsystem for
which you want to perform the setup tasks. The Subsystem Management
window opens.

2. Click the Summary tab.
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3. On the Summary page, click Perform Initial Setup Tasks. The Initial Setup
Tasks window opens, as shown in

% i9CSI3-Linux - Initial Setup

Use these B steps to set up the storage subsystem:
bienn Information Shout These Tasks| ﬂ

(1) Locate the Storage Subsystem

(2 Fename the Storage Subsystem

13 ) Set g Storage Subsystem Password

4 | Configqure Host Access

L5 ) Manage iSCSl Settings:
Change Target Authentication
Erter Mutusl &Authertication Permissions
Change Target Identification

Change Target Discovery
Configure iIZC5] Host Ports

6 Configure storage subsystem (2 options):

Altaratic [Simple)

Manual (Advanced) LI

¥ Do not show this again far thiz storage subsystem

Close |

Figure 17. Initial Setup Tasks window in the Subsystem Management window

Note: The Initial Setup Tasks window opens automatically each time you open the
Subsystem Management window, unless you select the Do not show this
again for this storage subsystem check box at the bottom of the window.

Creating a storage subsystem profile

Important: Create a storage subsystem profile and save it in a safe place
whenever you modify the arrays and logical drives in the storage subsystem. This
profile contains detailed controller information, including logical and physical disk
configuration information, that you can use to help recover the configuration in the
event of a failure. Do not save the profile in the logical drives that are created in the
DS3000 storage subsystem whose profile was collected and saved.

To save the storage subsystem profile, complete the following steps:

72 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware



On the Subsystem Management window, click Summary » Storage Subsystem
Profile. The Storage Subsystem Profile window opens.

Click Save As.

Select the sections that you want to save, and provide the file name in which to
save the Profile.

You can also click Support »+ Gather Support Information, as shown in|Figure 18
to collect the inventory, status, diagnostic, and performance data from the storage
subsystem and save them to a single compressed file.

Support = Gather Suppont Information
Gather Support Information

Specity & file rae and locstion for the Suppor data fle and click start to save all suppont data

File:

ot Close

Figure 18. Gather Support Information window

Configuring host access

Before you use the logical drives in a host server, you must define and configure a
host for access.

To configure host access, complete the following steps:

1.

Click the Configure tab in the Subsystem Management window. Choose one of

the following options:

« To configure host access automatically, click Configure Host Access
(Automatic) and follow the wizard instructions. After you have completed the
instructions in the wizard, you are finished with this procedure.

Note: To detect hosts automatically, the Storage Manager 2 Agent service
must be running. Make sure that SMagent is installed before you
proceed.

» To configure host access manually, click Configure Host Access (Manual)
and continue to step E|

When the Configure Host Access (Manual) wizard starts, specify a host name

and host type, and then click Next.

Note: Before you use the logical drives in a host server, you must specify the
correct host type. The host type determines how the storage subsystem
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controllers will work with each operating system on the hosts to which
the controllers are connected. For the supported host types, see the
Storage Manager software readme file.

3. When the Specify HBA Host Ports area is displayed, add the known or new
host bus adapters in the Selected HBA host port identifiers/aliases field, and
then click Next.

4. (Optional) When the Specify Host Group area is displayed, specify a host
group that will share access with logical drives. When you specify a host group,
you can create a new host group or select an existing host group that has
already been defined. Select No or Yes, and then click Next.

Defining host groups

A host group is an entity in the Storage Partitioning topology that defines a logical
collection of host servers that require shared access to one or more logical drives.
You can grant individual hosts in a defined host group access to additional logical
drives that are not shared by other nodes, but this requires an additional storage
partition. You can make logical drive-to-LUN mappings to the host group or to an
individual host in a host group.

Important: If you have purchased a Storage Partitioning premium feature, make
sure that the premium feature is enabled. See the instructions for
enabling premium features that came with your key, or contact your
technical-support representative if you are unable to enable a premium
feature.

Note: You can configure heterogeneous hosts when you define a host group. This
enables hosts running different operating systems to access a single storage
subsystem.

To define a host group, complete the following steps:

1. On the Subsystem Management window, click Configure » Create Host Group
to start the Create Host Group wizard.

2. When the Create Host Group area is displayed, enter a name for the host
group and add any available hosts to the host group.

3. Click OK.

Note: To add hosts to the host group at this time, available hosts must already
be configured for access. You can first create a host group without
adding hosts and then add hosts later, using the Create Host Access
Manual) wizard. For more information, see [‘Configuring host access” on|

Creating arrays and logical drives

A redundant array of independent disks (RAID) array is a set of hard disk drives
that are logically grouped together.

A logical drive is a logical structure that is the basic structure that you create to

store data on the storage subsystem. The operating system recognizes a logical
drive as a single drive. Choose a RAID level to meet application needs for data

availability and to maximize I/O performance.

The maximum number of drives that are supported in an array is 30. Each array
can be divided into 1 through 256 logical drives.
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To create arrays and logical drives, complete the following steps:

1. From The Enterprise Management window, double-click a storage subsystem
to open a Subsystem Management window.

2. Click the Configure tab.

3. Click Create Logical Drives. The Create Logical Drives wizard starts and the
Select Capacity Type window opens.

E5 FULL IBM System Storage DS3000 Storage Manager 2 (Subsysten Management) i =10l x|

Ee | | & O

| Ssummary | Configure Support |

Confiaure = Create Logical Drives

Create Logical Drives - Select Capacity Type @ view Frequentty Asked Quedlions

Choose the type of capacity to use:
@ Unconfigured capacity: create a new an array and logical drive.

€ Fres capacity: use capacity from an existing array.

Select a free capacity node:

% Arvety 3 (RAID 5)
% Array 4 (RAID 51
% Arrery 5 (RAID 3)
a % Array 6 (RAID 5)
% Array 7 (RAID 31
% Aty 6 (RAID 5)
i % Array 8 (RAID 5)

hiest = cancel

Figure 19. Create Logical Drives wizard window

4. Select Unconfigured capacity or Free capacity, and then click Next.

Note: When you select Free capacity, you must first select the free capacity
node from an existing array before you proceed with the wizard.

If you select Unconfigured capacity, skip to step|10 on page 77|

5. From the Select drive type list, select SAS or SATA.
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% FC IBM System Storage DS3000 Storage Manager 2 (Subsystem Management) 1

B Initial Setup Tasks

e = B - - |
AR AR
| Summarny Configure Mod_ify Tools Support |
Confiqure > Create Logical Drives
ij Create Logical Drives - Select Capacity Type @ View Frequentty Asked Questions

Choose the type of capacity to use:

¥ Unconfigured capacity: create a new an array and logical drive.

Select drive bype:

[

& i LAY = capacity from an existing array,
[ sas
Selert afree capacity node:

covs |

Figure 20. Selecting the capacity type

Note: You must create arrays by using drives that have the same disk type.
You cannot mix both SATA and SAS drives within the same array.

6. When the Drive Selection Choices area is displayed, select either Automatic
or Manual and click Next. If you select Automatic, continue to stepﬂ If you
select Manual, skip to step

Note: Selecting Automatic is preferred for quick and easy configuration. This
method enables you to choose from a list of automatically generated
drive and capacity options. Selecting Manual gives advanced users a
method for specifying drives to create a new array.

7. When the Choose Configuration (Automatic Configuration) area is
displayed, select a RAID level and click Finish.

Note: Depending on the selected RAID level, the automatic configuration
configures all remaining unconfigured capacity that is currently available
on the storage subsystem. Check the Configuration summary field for
details about what will be configured.

8. When the Manual Drive Selection area is displayed, as shown in[Figure 21]
select the RAID level. Select the drives from the Unselected
drives area and click Add to move the drives to the Selected drives area. In
the Selected drives area, click Calculate Capacity, and then click Next.
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3 FULL IBM System Storage DS3000 Starage Manager 2 (Subsystem Management) ) 1ol x|

|| a 9
Summary | Configure Modify Tools Support |
Confioure > Create Losical Drives
Create Logical Drives - Manual Drive Selection @ view Freouerty Asked Questions.

Choose & RAID level, add drives, and caloulats the capacity for the array

RAID levet

- Select ot least 3 drives (up 10 & maximum of 30)
feps =
nselected drives: elected drives:
En...[ it | Capacity Speed (ram) Type [ en.| st Capacity Speed (ram) Type
i 11 780 10,002 545 &  e7smecE 10002 545
i 12 s7mscE 10,002 sas & e7amsce 10,02 sas
2 2 e7eeecE 10,002 543 i = 10 e7sEeGE 10002 545
3

5 67.866GB 1516 s
“Remove
ety
RAID 5 array capacity: 135.731 GB
Murmber of drives: 3
Enciosure oes pratection: () No
< Back hext = Cancel

Figure 21. Manual drive selection area

9. When the Specify Logical Drive area is displayed, specify the capacity,
name, and I/O characteristics of the logical drive, and click Next.

10. When the Map Logical Drive To Host area is displayed, select Map now to
map a logical drive immediately, using the host that you defined in
|host access” on page 73|or Map later to map a logical drive at a later time,
and then click Next.

Notes:

a. If you did not configure hosts previously, a warning message is displayed.
Read the message and click OK; then, continue with the Create Logical
Drives wizard.

b. To map the logical drive immediately, you must have previously configured
a host or host group (be sure to assign a LUN number for your logical
drive before you continue). If you select Map later, you can map the logical
drive through the Create Host-to-Logical Drive Mappings wizard. For more
information, see[‘Mapping LUNSs to a partition.’]

Note: For cluster configurations, if you add or delete logical drives, you must make
them known to both nodes A and B.

Mapping LUNs to a partition

Logical unit numbers (LUNs) are assigned to each logical drive when they are
mapped to a partition.

To map LUNs to a new or existing partition, complete the following steps:

1. On the Subsystem Management window, click Configure » Create
Host-to-Logical Drive Mappings to start the wizard.

2. When the Select Host area is displayed, select a host or host group and click
Next.
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511-M55W IBM System Storage DS3000 Storage Manager 2 (Subsystem Management) B

B Initial Setup Tasks

¢ | @

M )

Summany Configure Modify Tools iSCSI Support
Configure > Create Host-to-Logical Drive Mappings
% Create Host-to-Logical Drive Mappings - Select Host @ view Frequently Asked Questions

Mote: If a particular host is not listed, you need to make the host available For mapping using the Configure Host Access {Automatic) task under the Configure Tab,

Select a hast group or host:

ﬁ Storage Partitions - Allowed: 4 Used: 1

Mote: If you wank to map a logical drive ko more than one host, you must first create a host group using the Create Host Group bask under the Configure tab,

cos |

Figure 22. Create host area

3. When the Select Logical Drives area is displayed, select the logical drives that
you want to map to the specified host, and click Finish.

Configuring hot-spare devices

You can assign available physical drives in the storage subsystem as hot-spare
drives to keep data available. A hot spare is a drive that contains no data and that
acts as a standby in case a drive fails in an array. If the drive in an array fails, the
controllers automatically use a hot-spare drive to replace the failed drive while the
storage subsystem is operating. The controller uses redundancy data to
automatically reconstruct the data from the failed drive to the replacement
(hot-spare) drive. This is called reconstruction.

The hot-spare drive adds another level of redundancy to the storage subsystem. If
a drive fails in the storage subsystem, the hot-spare drive is automatically
substituted without requiring a physical swap. If the hot-spare drive is available
when a logical drive fails, the controller uses redundancy data to reconstruct the
data from the failed logical drive to the hot-spare drive. When the failed drive is
replaced or another drive is designated as a replacement, the data from the
hot-spare drive is copied back to the replacement drive. This is called copyback.
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To assign a hot-spare drive, open the Subsystem Management window, click the
Configure tab, and select one of the following options:

+ Automatically assign drives. If you select this option, hot spare drives are
automatically created for the best hot spare coverage using the drives that are
available.

* Manually assign individual drives. If you select this option, hot spare drives
are created out of available drives that are manually selected from the Configure
Hot Spares window.

If you choose to manually assign the hot-spare drives, select a drive with a capacity
equal to or larger than the total capacity of the drive you want to cover with the hot
spare. For maximum data protection, do not assign a drive as a hot-spare unless its
capacity is equal to or greater than the capacity of the largest drive on the storage
subsystem. Use only the largest capacity drives for hot-spare drives in mixed
capacity hard disk drive configurations.

Replacing a hard disk drive

If a hard disk drive fails and a hot-spare drive is available, the hot spare begins a
reconstruction process to temporarily replace the failed drive. With the configurable
drive replacement policy, you can choose one of the following options:

* Replace the failed drive with a replacement drive. The replacement drive
performs a copyback operation from the hot-spare drive and becomes part of the
array.

* From the Replace Drive window (on the Modify tab), select the hot-spare drive
that is currently part of the degraded array, to become a permanent member of
the array.

* From the Replace Drive window (on the Modify tab), select another available
drive in the storage enclosure to become designated as the replacement drive.
This drive performs a copyback operation from the hot spare and becomes part
of the array.

Note: The selection of a replacement drive cannot be completed until a hot-spare
drive has completed its reconstruction process.
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Managing iSCSI settings (DS3300 only)

Note: The iSCSI tab on the Subsystem Management window is available only for
DS3300 storage subsystems.

On the Subsystem Management window, click the iSCSI tab. A window similar to
the one in the following illustration opens.

SCS15-MS-Portfailover IBM System Storage DS3000 Storage Manager 2 {Subsystem Management)

B initial Setup Tasks

Summary

%

Configure

iSCSI

9

Support

- | i)

Modify ools

Manage iSCSI Settings

Authentication

Change Target Suthentication
Choose which authentication methods will be required in order for an initiator to access the target. You will alzo define the permissions needed for each
authertication method if required.

{:3&'3 Enter hutual Suthertication Permizsions
t;,- Thiz tazk is only required if any of the defined intistors reguire mutual authertication. You can enter the inttistor's permissions in this task in order for the
target to access the intistor. Note that this task is used to enter secret words that have already been defined on the intistar's host.

Identification and networking

Change Target identification
Define ah easy-to-rememnber aliss for the target for easy idertification. You can also find the target's ISCS! name in this task.

@ hange Target Discover:
Configure parateters for howe the target will be discovered on the network, such as ISMNS server settings

@& Configure iSCE Host Parts
Configure network parameters for the ISCS| host ports onthe cortroller(s) such as IP configuration and other advanced functions.

Sessions and statistics

§F - Wiew/End iSCE| Sessions
Wiewy detailed iSCEl zessions and connection information and end iISCE] sessions.
[EE] view iscs) Stafistics
— | Wiew and zave iSCSl port and target statistics for thiz storage subsystem,

Figure 23. Manage iSCSI settings page

The following options are available from the iSCSI page:
» Change Target Authentication

* Enter Mutual Authentication Permissions

» Change Target Identification

* Change Target Discovery

» Configure iSCSI Host Ports

* View/End iSCSI Sessions

» View iSCSI Statistics
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Changing target authentication

Select Change Target Authentication to specify the target challenge handshake
authentication protocol (CHAP) secret that the initiator must use during the security
negotiation phase of the iSCSI login. By default, None is selected. To change the
selection, click CHAP, and then type the CHAP secret. You can select the option to
generate a random secret if you want to. This enables 1-way CHAP.

Entering mutual authentication permissions

Before you select Enter Mutual Authentication Permissions, you must define a
host port for the initiator and enable Target Authentication. After the host port is
listed, select the host from the list and click Chap Secret to specify the secret that
is passed to the initiator from the target to authenticate it. This enables Mutual
CHAP (2-way).

Changing target identification

Select Change Target Identification to specify a target alias that is to be used
during device discovery. You must provide a unique name for the target that
consists of fewer than 30 characters.

Note: You will connect to the target by using the fully qualified IQN that is listed
above the alias.

Changing target discovery

Select Change Target Discovery to perform device discovery by using the iSCSI
simple naming service (iISNS). After you select this option, select the Use iSNS
Server check box. You can also select whether the iISNS server is discovered using
a DHCP server on your network, and you can manually specify an Internet Protocol
version 4 (IPv4) or IPv6 address. When you click the Advanced tab, you can
assign a different TCP/IP port for your iSNS server for additional security.

Note: To provide the required port login information for correct device discovery, all
iSCSI ports must be able to communicate with the same iSNS server.

Configuring iSCSI host ports

Select Configure iSCSI Host Ports to configure all of the TCP/IP settings. You can
choose to enable or disable IPv4 and IPv6 on all of the ports. You can also
statically assign IP addresses or let them be discovered using DHCP. Under
Advanced IPv4 Settings, you can assign VLAN Tags (802.1Q) or set the Ethernet
Priority (802.1P). Under Advanced Host Port Setting, you can specify a unique
iSCSI TCP/IP port for that target port. You can also enable Jumbo Frames from this
option. The supported frame sizes are 1500 and 9000.

Viewing or ending an iSCSI session

Select View/End iSCSI Sessions to view all of the connected iSCSI sessions to
the target. From this page, you can also close an existing session by forcing a
target ASYNC logout of the initiator session.

Viewing iSCSI statistics

Select View iSCSI Statistics to view a list of all iISCSI session data, for example,
the number of header digest errors, number of data digest errors, and successful
protocol data unit counts. You can also set a baseline count after a corrective action
to determine whether the problem is solved.

Chapter 8. Completing the Storage Manager software installation and configuration ~ 81



Determining firmware levels

Method 1

There are two methods for determining the DS3000 storage subsystem, expansion
unit, drive, and ESM firmware versions. Each method uses the Storage Manager
Client that manages the DS3000 storage subsystem with the attached expansion
unit.

Open the Subsystem Management window and click the Summary tab. Select
Storage Subsystem Profile in the Hardware Components area. When the
Storage Subsystem Profile window opens, select one of the following tabs to view
the firmware information.

Note: The Storage Subsystem Profile window contains all the profile information for
the entire subsystem. Therefore, you might have to scroll through a large
amount of data to find the information that you want.

Summary

* Firmware version (controller firmware)
* NVSRAM version

The following example shows the profile information on the Summary page.

| £ Storage Subsystem Profile. ] i X
E Logical Drives | Drives | aDrive Channelz | E'i Enclozures | Mappings | %AH
[z2] Surmmaey | [ cortraliers % Atrays
Current configuration ;I
Firmware wersion: 96.17.41.03
NVSRAM wersion: N1726D3ZLRAL17V03
Pending configuration
Staged firmware dowmload supported: Yes
Firmware wersion: None
HVSRAN werzion: Hone
Transferred on: None
Controller enclosure audible alarm: Disghled
WWERLM ~enfiemirad For khatteariass Vea LI
Find:
-] #H Save As | Cloze | Help |
Results:

Figure 24. Example of profile information on the Summary page
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Controller
* Firmware version
* Appware version (Appware is a reference to controller firmware)
* Bootware version (Bootware is a reference to controller firmware)
* NVSRAM version

The following example shows the profile information on the Controller page.

& Storage Subsystem Profile %]

E Logical Drives | a Drives I a Drive Channgels | E‘i Enclosures | ﬁ Mappings | All
B Surmmary ! Cortrollers % Arrays
Controller in Enclosure 0, Slot A ;l
Status: Online —I
Current configuration
Firmware wersion: 96.17.41.03
Appware wersion: 96.17.41.03
Bootware wersion: 96.17.41.03
HVSRAN wersion: H17Z26D3ZLR917V03
Pending configuration
Firmware version: Hone
innuare werainn: Hene =
Find:
I £ a Save As... | Cloze | Help |
Results:

Figure 25. Example of profile information on the Controller page

Enclosures
* Firmware version

The following example shows the profile information on the Enclosures
page.

F5 Storage Subsystem Prafile . X

E Summary | ! Contrallers | % Arrays
E Logical Drives | @ Drives a Drive Channels E? Enclosures | ﬁ Mappings All
Date of mamufacture: Jamuary 1, 2006 _:I
2 EZM Canisters Detected
ESM card status: Optimal -
Firmware wersion: 0la4d
Maximum data rate: 3 Ghp=
Current data rate: 3 Gbps
Location: 4 (left)
Card communication: [1):4
Brndint TTis FYDRANA ﬂ
Find:
;I El Save Az Help
Results:

Figure 26. Example of profile information on the Enclosures page
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Drives
* Firmware version (drive firmware)

The following example shows the profile information on the Drives page.

% Storage Subsystem Profile il LI
@ Summary | ! Controllers | % Arrays
E Logical Drives Drives = Drive Charnels | E'i‘ Enclosures | hlappings | @ All

-

PROFILE FOR 3TORAGE SUESVITEM: SIMPLEX (10/24/08 7:21:00 FM)

DRIVE.

STUIMMARY
Huwber of driwes: 1
Current driwve types: Serial Attached 3C3I (343) (1)

BASIC:

TRAY, SLOT STATUS CAPACTITY TYPE CURRENT DATA RATE PRODUCT ID FIRMWARE VERSION
o, 1 Optimal 33.902 GB 5435 3 Ghps ST33675455 Bald
%
4] _*l_‘
Find:
Iﬁ H Save As.. | [ Close Help |

Results:

Figure 27. Example of profile information on the Drives page

Method 2

Open the Subsystem Management window and select Download Firmware on the
Support page. Select one of the following options to view the firmware information.

Note: Use method 2 only to make sure that the firmware versions are correct. After
you check the firmware versions, cancel or close the windows to avoid
downloading firmware unintentionally.

Download controller firmware

» Firmware version (controller firmware)
* NVSRAM version

Download NVSRAM
* NVSRAM version

Download drive firmware
* Firmware version (drive firmware)

Download Environmental Services Monitor (ESM) firmware
* Enclosure firmware version

Downloading controller, NVSRAM, ESM, and hard disk drive firmware

Note: You can download the latest versions of DS3000 storage subsystem
controller firmware, NVSRAM, EXP3000 ESM, and hard disk drive firmware
at |http://www.ibm.com/servers/storage/support/disk/}

Important:

1. IBM supports the download of controller firmware and controller NVSRAM with
I/O (in a dual-controller configuration), which is sometimes referred to as
concurrent firmware download. Before you proceed with concurrent firmware
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download, see the readme file that is packaged with the firmware code or see
your DS3000 Storage Manager host software for any restrictions to this support.

Stop all I/0O activity while you download firmware and NVSRAM to a DS3000

storage subsystem with a single controller, because you will lose the
connections between the host server and the DS3000 storage subsystem.

This section provides instructions for downloading DS3000 storage subsystem

controller firmware and NVSRAM, EXP3000 ESM firmware, and drive firmware.

Normally, the DS3000 storage subsystem firmware download sequence starts with

controller firmware, followed by the NVSRAM and then the ESM firmware, and
concludes with the hard disk drive firmware.

Downloading controller or NVSRAM firmware
To download the DS3000 storage subsystem controller firmware and NVSRAM,

complete the following steps:

1. From the Enterprise Management window, open the Subsystem Management

window by double-clicking a storage subsystem.

2. Click Support » Download firmware » Download Controller Firmware. The

Download Controller Firmware window opens, as shown in [Figure 28|

Currert cortroller firmvare ve

rsior: Pkoinfo 9517 41.05

Selected cortroller firmware fik:
[ [ seectie. ||

File information,

I Transter NVSRAM tile wih cortroller fimrare
Currert NYSRAM version: N1726D320RE1 7414

Sl rted [IVERAN 11
[ Select File

File informetior

Transter.., Carcel Help

Figure 28. Download Controller Firmware window

3. To select the controller firmware file, click Select File next to the Selected
controller firmware file field, and then browse to the file that you want to
download.

4. To select the NVSRAM file, click Select File next to the Selected NVSRAM file

field, and then browse to the file that you want to download.

To transfer the NVSRAM file with the controller firmware, select the Transfer

NVSRAM file with controller firmware check box.
5. Click Transfer.
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Downloading ESM firmware
To download the ESM firmware, complete the following steps.

Note: Downloading ESM firmware must be performed with all I/O quiesced.

1. In the Subsystem Management window, click Support »+ Download firmware »
Download Environmental (ESM) Card Firmware. The Download
Environmental (ESM) Card Firmware window opens.

52 Download Environmental {(ESM) Card Firmware

Select a firmweare file to transter new firmyeare from this management station to the selected environmental (ESM) cards on Storage
Subsystem FC.

- Drive enclosur
Select enclosures: [ Select A1l

Maimum Card A Card B
Dsts Rate Product ID Product ID
Enclosure 1 |3 Ghps lEm-ESKS |15 M 21204-00 [0158 P 21204-00 | |

Card
hianufacturer

Card &
Firmvare

Card B
Firmaare

Enclosure ID Status

~ESM firmweare

Selected ESM firmware file information:

Select Fils:, |

Please select enclosures and specify firmware file.

Start | Cloze | Help |

Figure 29. Download Environmental (ESM) Card Firmware window

2. Select the Select All check box to direct the download to all enclosures. You
can also select one enclosure or combinations of enclosures by pressing the
Ctrl key while you select the individual enclosures.

3. To select the ESM firmware file, click Select File next to the Selected ESM
firmware file information field, and then browse to the file that you want to
download.

4. Click Start to begin the ESM firmware download. A Confirm Download window
opens.
5. Type yes and click OK to start the download process.

6. When the ESM firmware download for all selected enclosures is completed,
click Close.

Automatic ESM firmware synchronization

When you install a new ESM in an existing storage expansion enclosure that is
connected to a DS3000 storage subsystem that supports automatic ESM firmware
synchronization, the firmware in the new ESM is automatically synchronized with
the firmware in the existing ESM. This resolves any ESM firmware mismatch
conditions automatically.

Note: Automatic ESM firmware synchronization can be performed only after an

ESM firmware file is successfully downloaded to an ESM in the storage
expansion enclosure.
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To enable automatic ESM firmware synchronization, make sure that your system
meets the following requirements:

* The Storage Manager Event Monitor is installed and running.

» The DS3000 storage subsystem is defined in the Storage Manager Client
(SMclient) Enterprise Management window.

Downloading drive firmware

This section provides instructions for downloading DS3000 drive firmware. For more
information, see the online help.

Important: Before you start the drive firmware download process, complete the
following tasks:

» Stop all /0 activity before you download drive firmware to a DS3000
storage subsystem.

* Unmount the file systems on all logical drives that access the drives
that you select for firmware upgrade.

» Complete a full backup of all data on the drives that you select for
firmware upgrade.

To download the drive firmware, complete the following steps:

1. On the Enterprise Management window, open a subsystem management
window by double-clicking a storage subsystem.

2. Click Support » Download firmware » Download Drive Firmware. The
Download Drive Firmware windows opens.

&% Download Drive Firmware - Select Packages L. x|

Select the drive firmwware packages you would like to transfer. If you have more than one type of drive (vendor shd capacty), you
may select up to four packages to fransfer at a time.

~Currert drive firmware package information

Drive product ID= and firmware versions: ST33675455(6418)

~Selected package:

Packages to be transferred:

Remove

Package information:
Drive vendor:
Drive procuct IOx
Proposed firmyware:
Compatible firmware:

et Cancel | Help |

Figure 30. Download Drive Firmware window

3. Click Add to locate the server directory that contains the firmware that you
want to download.

4. Select the firmware file that you want to download and click OK. The file is
then listed in the Selected Packages area.

5. Select the firmware file for any additional drive types that you want to
download, and click OK. The additional files are then listed in the Selected
Packages area. A maximum total of four drive types are possible.
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6. Click Add to repeat step [5 on page 87| until you have selected each firmware
file that you want to download.

7. When you have finished specifying the firmware packages for download, click
Next.

8. In the Select Drive window (shown in , click the Compatible Drives
tab. The Compatible Drives page contains a list of the drives that are
compatible with the firmware package types that you selected. Press and hold
the Ctrl key while you use the mouse to select multiple drives individually, or
press and hold the Shift key while you use the mouse to select multiple drives
that are listed in series. The compatible firmware that you selected in steps
fon page 87|and |5 on page 87|are downloaded to the drives that you select.

The fallowing tables display drives that are compatible and incompatible with the packages you selected. You may update the
firmwvare on one or muttiple drives, even if they are not &t the same initial firmware level. Select the drives you wish to update st
thiz time.

Important: You must stop all I'0 and unmount any file ystem on sl logical drives accessing the selected drives before starting
the transfer process

~Selected firmuvare packages - e
Drive product ID= and firmware versions: STI3675455(BA18) ‘

Cornpatible Drives I Incompeatible Drives I

Selectdrives: [ Select ll

‘ endor |Product ID|EncIDsure| Slat Type Current f...| Propose. .. Status Array Maode

Selectedfavailable drives: 141

= Back Finizh.. Cancel | Help I

Figure 31. Select Drive window

Note: The firmware packages that you select to download should be listed on
the Compatible Drives page. If the product ID for your drive matches
the firmware type but it is not listed as compatible on the page, contact
your technical-support representative for additional instructions.

9. Click Finish to initiate the download of the drive firmware to each compatible
drive that you selected in step @

10. When the Download Drive Firmware warning window opens and the message
Do you want to continue? is displayed, type yes and click OK to start the
drive firmware download. The Download Progress window opens, as shown in
[Figure 32 on page 89 Do not intervene until the download process is
completed.
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Xl Download Drive Firmware - Progress

Drives updated.
“endor | Product 10 I Enclosure | rlot I Type I Proposed Fir. | Array | Status | Progress |
IBM-ESXS ST33675435 .0 1 by SAS BA1S 1 Optirrial Successful

Progress summary -

| ENNNENNRNENEENN RN RN RN RN RNRERRRNNNNERNRNNENENNRNENENNNENNENRREER
|
| Scheduled In progress Failed-partis| Failed-invalicd state  Falled-other Mot attempted Successul
i1 i i i 0 i 1
Transter More... | Stop | SEve AS... | Cloze | Help |

Figure 32. Download Progress window

Every drive that is scheduled for firmware download is designated as in
progress until it is designated as successful or failed.

11. If the download for a drive fails, complete the following steps:
a. Click the Save as button to save the error log.

b. On the Subsystem Management window, click Support » View Event Log
and complete the following steps to save the storage subsystem event log
before you contact your technical-support representative:

1) Click Select all.
2) Click Save as.
3) Provide a file name to which to save the log.
When the Close button is active, the drive firmware download process is
completed.
12. Click Close.

Array import and export functions

The array import and export functions enable the transfer of configurations between
DS3000 storage subsystems.

Important: The array import and export functions are available for only DS3000
storage subsystems that are running controller firmware version 07.35
or later. This function does not work with storage subsystems or arrays
that are using controller firmware version 06.xx.

Exporting an array
To export an array, complete the following steps:
1. In the Subsystem Management window, click the Advanced Support tab.

2. Click Export Array. The Export Array wizard opens. The wizard helps you
prepare an array for export from one storage subsystem to another storage
subsystem.
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Important: Before you start the export function, you must stop all 1/0O to the
array that you are exporting.

3. Select the array that you want to export and click Next.

EE i8CSI4-Lin-HW - Introduction (Expork Array)

This wizard will help vou prepare an array to be exported From this storage

1%- v subsystern into a different storage subsystem, To ensure your data is
protected, ensure that vou read and follow the instructions very carefully.
il 1 You will need ko stop [0 to the array you inkend ko Export before you beain
the export operation.
=

musk be Cormplete and Optimal before being exported.

LL1] @ The Following list shows the arrays that are eligible to be exported. Arrays

Seleck an array to export:

[RAIDS)

% Array SAS (RAIDL)

% Array compressArray (RAIDS)

[

% Array R10-RHEL (RAIDL)

Cancel | Help |

Figure 33. Selecting an array in the Export Array wizard
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4. The Preparation Checklist window opens and provides a list of procedures that
you must complete before you can export an array.

% isC5I4-Lin-HW - Preparation Checklist (Expor

You must perform the Following procedures before you can export array compressarray, Do nok
continue until you are certain that all procedures have been completed.

Preparation checklist:

B source storage subsystem iSCSI4-Lin-HW instructions:
On the storage subsystem from which the array will be exported:

[¥ Save the storage subsystem configuration

Thiz is a precaution to help you restore your configuration in the event of a
[ Stop all /O

stop all input and output and vn-mount or disconnect file systems on the o
¥ Back up array data

Baclk up data on the logical drives in the array selected for export.
¥ Locate the array and label drives

Uze the locate array function to flash the LED s on the drives in the array, &

3 Mihdndan Rlasnde dudenn ...-..I:.ﬁ.“,..-. TR [

4

-
3
Maote: You musk check all of the checkboxes before you can proceed. Save As... |

< Back | Finish I Zancel | Help |

Figure 34. The Export Array Preparation Checklist window

5. After you complete the preparation checklist, click Finish.

6. In the Confirm Export window, type yes to begin the import operation process,
and then click OK.

7. When the export operation is completed, you can remove the hard disk drives
from the storage subsystem.

Importing an array
To import an array, complete the following steps:

1. Insert the hard disk drives that are associated with the exported array in the
storage subsystem.

2. In the Subsystem Management window, click the Advanced Support tab.
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3. Click Import Array. The Import Report window opens and shows the details of

the array that you are importing.

You must insert all drives in the walume group before the wolume group can be imported. IF you do nok
hawe the Full set of drives composing the volume group, you can Force the volume group inko an
importable state,

Wehen should 1 Force drives inbo an importable skate?

Import repork:

inserting drives.

|0

% Volume group information:

Volume group name; 0

Status: Exported - ready for import
Drestination storage array: 13 CE15toragel

E Drives: =

Tray Slot Capacity  TypeStatus

B 5 33419 GB 3AS Optimal
g5 7 33410 MR SAY Mntimal v/

< Back ][ Mexk = ][ Cancel ][ Help ]

i

Figure 35. Import Report window

4.

If the information in the report is correct, type yes in the Confirm Import window,
and then click OK to begin the import operation process.

Performing other storage-subsystem management tasks

The following list describes other storage-subsystem management tasks that you
can perform. You can perform the following tasks from the Subsystem Management
window.

Create hot spares (Configure » Configure Hot Spares)

Automatically create logical drives and hot spares (Configure » Automatic
Configuration)

Edit host topology configurations for the subsystem (Modify » Edit Topology)

Enter or change a storage subsystem password (Tools » Set or Change
Password)

View or change media scan settings (Tools »+ Change Media Scan Settings)
Locate a storage subsystem or its components (Tools » Locate)
View or enable premium features (Tools » View/Enable Premium Features)

Change enclosure identification numbers for a storage subsystem (Tools »
Change Enclosure ID Numbers)
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» Synchronize controller clocks (Tools » Synchronize Controller Clocks)

* Change the network configuration (Tools » Change Network Configuration)

* Reset the battery age (Tools » Reset Battery Age)

* Inherit system settings from the operating system (Tools » Inherit System
Settings)

* View the major event log (Support » View Event Log)

» Save all storage subsystem data (Support » Gather Support Information)

» Place controller online or offline (Support + Manage Controllers)

For more information about these and other storage-subsystem management tasks,
see the applicable topics in the Subsystem Management online help.

For advanced users: You can perform other storage-subsystem management
tasks from the Enterprise Management window by clicking Tools » Script Editor.
For more information, see the Enterprise Management window online help.

Note: If there is a problem with the storage subsystem, a Needs Attention status
icon is displayed in the Enterprise Management window next to the storage
subsystem. In the Subsystem Management window, a Storage Subsystem
Needs Attention link is displayed in the status area of the Summary page.
You can click the link to open the Recovery Guru. You can also open the
Recovery Guru by clicking Support » Recover from Failure in the
Subsystem Management window.

Best practices guidelines for the DS3300

For the best performance of the Storage Manager software and the DS3300 , follow
the guidelines in the following sections.

Microsoft iSCSI Software Initiator considerations

The native MPIO that is provided with the Microsoft iISCSI Software Initiator (version
2.03 or later) is not supported with the DS3300. You must use the DSM that is
provided with the Storage Manager software to make sure that failover and 1/0
access are correct. If the native MPIO from the Microsoft iISCSI Software Initiator is
used, it causes unwanted effects.

iISNS best practices

Using DHCP

There are many considerations for using an iISNS server correctly. Make sure that
you correctly assign your iSNS server address that is provided during the DHCP
lease discovery of your initiator or target. This enables ease of discovery when you
use software initiator-based solutions. If you are unable to do this and must
manually assign the iSNS server to your software or hardware initiators, you should
make sure that all ports for both the DS3300 target and the iSCSI initiator are in the
same network segment (or make sure that the routing between the separate
network segments is correct). If you do not do this, you will be unable to discover
all ports during the iISCSI discovery process, and you might not be able to correctly
perform a controller or path failover.

Using DHCP for the target portals is not recommended. If you use DHCP, you
should assign DHCP reservations so that leases are maintained consistently across
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restarts of the DS3300 storage subsystem. If static IP reservations are not provided,
the initiator ports can lose communication to the DS3300 controller and might not
be able to reconnect to the device.

Using supported hardware initiators

As of the date of this document, only the following hardware initiators are
supported:

* |IBM iSCSI Server TX Adapter

* IBM iSCSI Server SX Adapter

* QLogic iSCSI Single-Port PCle HBA for IBM System x
* QLogic iSCSI Dual-Port PCle HBA for IBM System x

All of the hardware initiators that are supported use the same base firmware code
and the SANsurfer management application. Before you install and configure these
adapters, make sure that you have installed the latest management application and
the latest firmware code. After you confirm this, configure each adapter one at a
time.

To make sure that failovers are performed correctly, connect each adapter by using
one of the following two basic configurations:

» If you have a simple configuration in which all adapters and target ports are in
the same network segment, each adapter should be able to log in to any target
port.

» If you have a complex configuration, each adapter is allowed a single path to
each controller device.

To log in correctly to all available target ports from the hardware initiator, complete
the following steps.

Note: Failure to perform the steps in the following procedure might result in path
failover inconsistencies and incorrect operation of the DS3300.

Start the SANsurfer management utility.

Connect to the system that is running the glremote agent.
Select the adapter that you want to configure.

Select Port 0 or Port 1 for the adapter.

Click Target Settings.

Click the plus sign (+) in the far right of the window.

Type either the IPv4 or IPv6 address of the target port to which you want to
connect.

8. Click OK.
9. Select Config Parameters.
10. Scroll until you see ISID.

11. For connection 0, the last character that is listed should be 0. For connection
1, it should be 1, for connection 2, it should be 2, and so on.

12. Repeat steps|§| throughfor each connection to the target that you want to
create.

13. After all of the sessions are connected, select Save Target Settings.

No o~ =

If you are using the QLogic iSCSI Single-Port or Dual-Port PCle HBA for IBM
System x to support IPv6, you should allow the host bus adapter firmware to assign
the local link address.
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Using IPv6

The DS3300 supports the Internet Protocol version 6 (IPv6) TCP\IP. Note that only
the final four octets can be configured if you are manually assigning the local link
address. The leading four octets are f€80:0:0:0. The full IPv6 address is required
when you are attempting to connect to the target from an initiator. If you do not
provide the full IPv6 address, the initiator might fail to be connected.

Network settings

Using the DS3300 in a complex network topology introduces many challenges. If
possible, try to isolate the iSCSI traffic to a dedicated network. If this is not
possible, follow these suggestions:

» If you are using a hardware-based initiator, the Keep Alive timeout should be 120
seconds. To set the Keep Alive timeout, complete the following steps:
1. Start the SANsurfer Management Utility and connect to the server.
2. Select the adapter and the adapter port that is to be configured.
3. Select the port options and firmware.

The default connection timeout is 60 seconds. This setting is correct for
simple network topologies; however, if a network convergence occurs and
you are not using Fast Spanning Tree and separate spanning tree domains,
in a more complex configuration, you might encounter I/O timeouts.

+ If you are using a Linux software initiator to connect to the DS3300, modify the
ConnFailTimeout to account for the spanning tree issue that is described in step
The ConnFailTimeout value should be set to 120 seconds.

Operating system consideration

For the best performance, do not enable Data and Header Digest when using the
embedded software initiators with the Red Hat Enterprise Linux 4 and SUSE Linux
Enterprise Server 9 operating systems. If these functions are enabled, you will see
degraded performance and in the case of multiple hosts accessing the same
DS3300 storage subsystem, you might see that a path is marked incorrectly as
having failed.

SATA disk drive best practices guidelines

If you use a stripe size of 8 KB, you cannot perform a format of a Linux ext2 file
system on a logical drive configured with SATA drives. For the best performance,
use a stripe size of 32 KB or larger when using SATA disk drives.

Fibre Channel best practices guidelines

If you install your Linux host with the QLogic host bus adapter installed in the host,
the default device driver provided with the distribution is installed. The device
drivers that are installed by the Linux installation have HBA failover support
enabled. If these device drivers are used with the RDAC multipath support software,
it might prevent RDAC from discovering all the available controller paths. You must
install the most current HBA device drivers that are provided for your solution and
make sure that the ramdisk image is remade with the most current HBA device
drivers before you install the MPP failover driver. Failure to do so results in incorrect
controller and path failover.

If you use the Emulex 4 GB Host Bus Adapter with Novell NetWare 6.5, you must
add the following parameter to the driver load line:

N_TIMEOUT=0
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Storage Manager 2 Enterprise Manager view and Subsystem
Management view best practices guidelines

Consider the following information before you use the Storage Manager 2
Enterprise Management view and Application Management view:

The current command to gather performance statistics (save storagesubystem
performancestats=filename.xls;) does not gather any valid data. All of the values
are zero (0). As of the date of this document, there is no workaround available.

To create a logical drive using the smcli or Enterprise Manager script editor you
must make nsure that the syntax of the command is correct. When you specify a
logical drive size, the correct syntax is:

create logicalDrive array[array number] capacity=size of logical drive TB/GB/MB;

Note: There must be a space before TB/GB/MB; otherwise, the command does
not work.

The Storage Manager 2 Application Management view is limited to creating a
maximum of 64 FlashCopies and 128 VolumeCopies. However, using the
Storage Manager command-line interface enables a maximum of 128
FlashCopies and 255 VolumeCopies to be created.

If you are updating a DS3000 storage subsystem, the first controller firmware
download might fail. If this occurs, start the firmware download a second time
and verify that the firmware is successfully downloaded. If the firmware download
fails again, contact your IBM technical-support representative.

To expand a logical drive using the smcli or Enterprise Manager script editor you
must make nsure that the syntax of the command is correct. When you specify a
logical drive size, the correct syntax is:

set logicalDrive[logical drive name]
addCapacity=size_to_increase_logical_drive_by TB/GB/MB;

Note: There must be a space before TB/GB/MB; otherwise, the command does
not work.

When you map a FlashCopy logical drive to the NetWare host that the base
logical drive was attached to, complete the following steps:

1. Unmount the base logical drive from the host.

Remove the storage partition containing the base logical drive.
Disconnect the session from the client to the NetWare host.
Map the FlashCopy logical drive to the host.

Mount the FlashCopy volume and perform the required actions.
Reconnect the client to the NetWare host.

For the best performance and to avoid having to complete the previous steps,
always mount the FlashCopy logical drive to a secondary host.

If you are using a firewall between your management client and the host agent
that is managing the controller or the controller TCP/IP address, make sure that
you have created an exclusion for TCP/IP port 2463. This port is used by the
Storage Manager software to communicate to the storage subsystem.

When you perform an upgrade to the Storage Manager software from any
previous version to Storage Manager version 06.70.xx.xx, you must perform a
new discovery of all your storage subsystems again. The previous management
domain is not maintained.

o ok w0

96 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware



Chapter 9. Completing storage-management tasks for
Windows hosts

This chapter provides information about how to add or delete logical drives, use the
hot_add and SMdevices utilities, start and stop the host-agent software, and
uninstall Storage Manager components in Windows operating system environments.

Adding or deleting logical drives

Use the following procedures to add or delete logical drives in a standard
(noncluster) or cluster configuration.

Standard (noncluster) configuration for Windows Server 2003 and
Windows Server 2008

Use the following procedures to create or delete logical drives in a standard
configuration.

Creating logical drives

When you create logical drives with the Storage Manager software, you must add
the new logical drives to the Windows Server 2003 or Windows Server 2008
operating system. Each logical drive is recognized by Windows Server as a single
disk drive.

After you create logical drives, to add them to the Windows Server 2003 operating
system, complete the following steps:

1. Right-click My computer; then, click Manage » Device Manager » Disk
Drives.

2. Click Actions » Scan for new or removed hardware.

After you add the logical drives, run the SMdevices utility that is provided with the
Storage Manager software. The SMdevices utility identifies logical drives by their
associated operating-system device names. For more information, see

[SMdevices utility” on page 98| and the online help.

Note: For Windows Server 2008, before disk initialization, make sure that the disk
device is Online. In the Computer Management window, click Disk
Management. The disk devices are displayed in the bottom area of the
window. Right-click the disk device that you want to put online and select
Online.

Deleting logical drives

Attention: You must use the Disk Administrator to delete the cluster physical disk
resources, delete operating-system partitions, and unassign drive letters before you
delete logical drives or reset the configuration in the Storage Manager software.
This action avoids damage to the registry information.

Before you delete logical drives with the Storage Manager, complete the following
steps:

1. Use the Disk Administrator to delete any partitions and to unassign drive letters
that are associated with the logical drives.

2. If possible, restart the system to remove the configuration information.
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Cluster server configuration for Windows Server 2003 and Windows

Server 2008

Use the following procedures to create or delete logical drives in a cluster server
configuration.

Creating logical drives

To add logical drives in a Windows Server 2003 or Windows Server 2008 cluster

server environment, complete the following steps:

1. Use the Storage Manager Client program to create arrays and logical drives and
use storage partitioning to assign them to the applicable cluster host group.

2. Use the hot_add utility to add the new logical drives to the cluster node that
currently owns the cluster quorum resource.

3. Use the Disk Administrator program to create, format, and assign drive letters to
the disk partitions on the new logical drives.

4. On each of the remaining cluster nodes in the cluster configuration, use the
hot_add utility to add the new logical drives to the cluster node.

5. In the first cluster node, use the Cluster Administrator program to create cluster
physical disk resources, using the new disk partitions on the new logical drives.

Note: If the new disk is not displayed in the available disk list when you go
through the Cluster Administrator program, you might have to restart the
server.

6. Bring the cluster resources online in the first cluster node.

7. Use the Cluster Administrator program to move the newly created cluster
physical disk resources to other nodes in the cluster configuration.

8. Make sure that the resources come online in other nodes in the cluster
configuration.

Deleting logical drives

Attention: To avoid damage to your registry information, you must use the Cluster
Administrator and Disk Administrator programs to delete the cluster physical disk
resources, delete operating system partitions, and unassign drive letters before you
delete logical drives or reset the configuration in the Storage Manager software.

Before you delete logical drives with the Storage Manager software, complete the
following steps:

1. Use the Cluster Administrator to delete the cluster physical disk resources that
own the logical drives that will be deleted.

2. Use the Disk Administrator to delete any partitions and to unassign drive letters
that are associated with the logical drives.

3. If possible, restart the cluster nodes to remove the configuration information.

Using the SMdevices utility

The SMutil software includes a utility, SMdevices, that you can use to view the
storage subsystem logical drive that is associated with an operating-system device
name. This utility is helpful when you want to create drive letters or partitions by
using Disk Administrator.

Note: The SMdevices command does not function with the DS3300 storage
subsystem.
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When you are finished creating the logical drives on a storage subsystem, to use
SMdevices, complete the following steps on the host that is attached to that storage
subsystem:

1. At a command prompt, change to the installation_directonjutil directory, where
installation_directory is the directory in which you installed the SMutil utility.

The default directory is c:\Program Files\IBM_DS3000\util.
2. Enter the following command:
SMdevices

The software displays device identification information. For example, you might
see the following information:

\\.\PHYSICALDRIVEx [Storage Subsystem finance, Logical Drive debit,
LUN xx, WWN worldwide_name]

where:

» xis the disk number that is displayed in Disk Administrator
» finance is the name of the storage subsystem

* debitis the name of the logical drive

» xx is the LUN that is associated with the logical drive

* worldwide_name is the worldwide name of the logical drive

Using the SMrepassist utility

You can use the SMrepassist utility to flush cached data for a logical drive.

Important: The FlashCopy drive cannot be added or mapped to the same server
that has the base logical drive of the FlashCopy logical drive in a Windows Server
2003 or NetWare environment. You must map the FlashCopy logical drive to
another server.

To flush cached data in a logical drive, complete the following steps:

1. At a command prompt, change to the installation_directonAutil directory, where
installation_directory is the directory in which you installed the SMutil utility.

The default directory is c:\Program Files\IBM_DS3000\util.
2. Enter the following command:
smrepassist -f logical _drive_letter

where logical_drive_letter is the operating-system drive letter that was assigned
to the disk partition that was created on the logical drive.

Stopping and restarting the host-agent software

You must stop and restart the host-agent software if you add storage subsystems to
the management domain of the host-agent software. When you restart the service,
the host-agent software discovers the new storage subsystems and adds them to
the management domain.

Note: If none of the access logical drives are detected after a restart, the
host-agent software automatically stops running. Make sure that the Fibre
Channel or iSCSI connection from the host to the SAN to which the DS3300
or DS3400 storage subsystem is attached is working correctly. Then, restart
the host or cluster node so that new host-agent-managed storage
subsystems can be discovered.
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To stop and restart the host-agent software for Windows Server 2003, complete the
following steps:

1.
2.
3.

Click Start » Administrative Tools » Services. The Services window opens.
Right-click IBM DS3000 Storage Manager 2 Agent.

Click Restart. The IBM DS3000 Storage Manager 2 Agent stops and then starts
again.

Close the Services window.

Uninstalling storage management software components

Use the following procedure to uninstall one or more of the components of the
Storage Manager 2 software. Existing storage array mappings and storage partition
configurations are retained during software removal and will be recognized by the
new client software.

Important: Do not uninstall the MPIO device driver unless you are instructed to do
so by your technical-support representative. The host-agent package requires MPIO
to function correctly.

To uninstall the Storage Manager 2 software, complete the following steps:

1.
2.

Click Start » Settings » Control Panel. The Control Panel window opens.
Select Add/Remove programs. The Add/Remove Programs Properties window
opens.

Select IBM DS3000 Storage Manager Host Software 02xx.x5.yy, where xx is
the main release (for example, 17) and yy is the version (for example, 01).
Click Change/Remove. The Uninstall program starts.

Click Next. The “Uninstall options” window opens.

Select to uninstall all installed DS3000 host-software packages or to uninstall
specific packages only, and click Next. If you selected to uninstall all
host-software packages, the program begins the uninstallation of all of the
installed host-software packages.

If you selected to uninstall a specific host-software package, select the
host-software packages that you want to uninstall, and click Uninstall.

Click Done to complete the DS3000 host-software uninstallation process. If you
are uninstalling MPIO, you must restart the host server.
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Chapter 10. Enabling and using premium features

Premium features provide enhanced functionality that enables you to perform tasks
that might be limited or unavailable with your base storage subsystem model.

You can purchase the following premium features for a DS3000 storage subsystem:
+ DS3000 FlashCopy Expansion License

» DS3000 Volume Copy License

» DS3000 FlashCopy Volume Copy License

» DS3000 Partition Expansion License

For information about how to purchase a premium feature, contact your IBM
marketing representative or authorized reseller.

Obtaining the activation key file and enabling a premium feature

Follow the Activation Instructions document that comes with your premium feature
to obtain the activation key file. The activation key file is required by the Storage
Manager software to enable the premium feature.

Enabling the DS3000 Partition Expansion License

You can upgrade the DS3000 Partition Expansion License from 4 to 16 partitions for
the storage subsystem. After you have obtained the DS3000 Partition Expansion

License key, to enable this feature in the Storage Manager software, complete the
following steps:

1. Open the Subsystem Management window and click Tools » View/Enable
Premium Features.

2. Under Enabled Premium Features, click Upgrade a feature, as shown in
[Figure 36 on page 102
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Figure 36. View/Enable Premium Features window

The Select Feature Key File window opens.

3. Select the feature key file that you obtained from the IBM Web site and click
OK.

4. In the Enable Premium Feature window, click Yes.

Enabling the DS3000 FlashCopy Expansion License

After you have obtained the DS3000 FlashCopy Expansion License key, to enable
this feature in the Storage Manager software, complete the following steps:

1. Open the Subsystem Management window and click Tools » View/Enable
Premium Features.

2. Under Disabled Premium Features, click Enable a feature, as shown in
. The Select Feature Key File window opens.

3. Select the feature key file that you obtained from the IBM Web site and click
OK.

4. In the Enable Premium Feature window, click Yes.

Enabling the DS3000 VolumeCopy License

Note: The terms VolumeCopy and Logical Drive Copy are used interchangeably
throughout this document, the Storage Manager Client program interface,
and the online help.

To enable the DS3000 Volume Copy License, complete the following steps:

1. Open the Subsystem Management window and click Tools » View/Enable
Premium Features.

2. Under Disabled Premium Features, click Enable a feature, as shown in
Figure 36, The Select Feature Key File window opens.

3. Select the feature key file that you obtained from the IBM Web site and click
OK.

102 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware



4. In the Enable Premium Feature window, click Yes.

Using the FlashCopy premium feature

A FlashCopy logical drive is a logical point-in-time image of a logical drive, called a
base logical drive. A FlashCopy logical drive has the following features:

* |t is created quickly and requires less disk space than an actual logical drive.

* |t can be assigned a host address, so that you can perform backups by using the
FlashCopy logical drive while the base logical drive is online and accessible.

* You can use the FlashCopy logical drive to perform application testing or both
scenario development and analysis. This does not affect the actual production
environment.

* The maximum number of FlashCopy logical drives that is allowed is one-half of
the total logical drives that are supported by your controller model.

For more information about the FlashCopy feature and how to manage FlashCopy
logical drives, see the Subsystem Management online help.

Important: The FlashCopy drive cannot be added or mapped to the same server
that has the base logical drive of the FlashCopy logical drive in a Windows Server
2003 or NetWare environment. You must map the FlashCopy logical drive to
another server.

To create a FlashCopy logical drive, complete the following steps:

1. To make sure that you have the accurate point-in-time image of the base logical
drive, stop applications and flush cache 1/O to the base logical drive.

2. Open the Subsystem Management window, click Configure » Create
FlashCopy Logical Drive, and follow the instructions in the wizard.

3. For instructions for adding the FlashCopy logical drive to the host, see the
Subsystem Management online help

Note: To manage created FlashCopy Logical Drives, click the Modify tab and
select Modify FlashCopy Logical Drives. Select Disable FlashCopy
Logical Drives, Re-create FlashCopy Logical Drives, or Expand the
FlashCopy Repository and then follow the instructions in the wizard.

Using VolumeCopy

The VolumeCopy feature is a firmware-based mechanism for replicating logical
drive data within a storage array. This feature is designed as a
systems-management tool for tasks such as relocating data to other drives for
hardware upgrades or performance management, data backup, or restoring
snapshot volume data. You submit VolumeCopy requests by specifying two
compatible drives. One drive is designated as the source and the other as the
target. The VolumeCopy request is persistent so that any relevant result of the copy
process can be communicated to you.

For more information about the VolumeCopy feature and how to manage
VolumeCopy logical drives, see the Subsystem Management online help.

To create a VolumeCopy, open the Subsystem Management window, click
Configure » Create Volume Copy, and follow the instructions in the wizard

Note: To manage created VolumeCopy logical drives, click Modify » Manage
Logical Drive Copies. A list of VolumeCopy requests is displayed. For each
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VolumeCopy, select Re-Copy or Stop, and to modify attributes, select
Permissions and Priority. |Figure 37| shows this tool.

PN_55 IBM System Storage DS3000 Storage Manager 2 {Subsystem Management)

52

¢ q .

Modify Tools

©
Summany Configure Support ‘
Modify = Manage Logical Drive Copies

Manage Logical Drive Copies @ view Frequentty Asked Questions

Source Logical Drive Target Logical Drive Status Timestamp Priority
x ot 1 4”9’“”
Stop

Permissinns |
Priority ... |
Retmove |

Total number of copies: 1 Estimated time retnaining: 3 minutes

4 Read-only logical drives

Close

Figure 37. Manage Logical Drive Copies window
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Appendix A. Storage subsystem and controller information
record

provides a data sheet for recording storage subsystem names,
management types, Ethernet hardware addresses, and IP addresses. Make a copy
of this table and complete the information for your storage subsystems and
controllers. Use the information to set up the BOOTP table for the network server
and the host or Domain Name System (DNS) table. The information is also helpful
if you add storage subsystems after initial installation. Each column heading
includes a page reference for detailed instructions for obtaining the information. For
a sample information record, see[Table 11 on page 25,

Table 12. Storage subsystem and controller information record

Storage
subsystem Management Controllers: Ethernet and IP addresses, and Host: IP address and host
name (page[24) |method (page[8) |host name (pages [24]and [25) name (page [25)
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Appendix B. Using the IBM System Storage DS3000 Controller
Firmware Upgrade Tool

— Important:
Use the IBM System Storage DS3000 Controller Firmware Upgrade Tool only
when you are migrating DS3000 controllers from version 06.22 or 06.24 to
version 07.35.

Do not use the controller firmware upgrade tool to perform standard upgrades
for controller, ESM, or hard disk drive firmware. To perform a standard
firmware upgrade for a DS3000 controller, EXP3000 ESM, or a hard disk
drive, see [‘Downloading controller, NVSRAM, ESM, and hard disk drivel|
firmware” on page 84/

Overview

Attention: To prevent the loss of date, before you use the controller firmware
upgrade tool to migrate from firmware version 06.22 or 06.24 to version 07.35, you
must backup all data and save the existing system configuration. After the upgrade
tool has completed a firmware upgrade, the DS3000 controllers cannot be returned
to previous firmware version levels.

Before you use the upgrade tool, read the following important information:
» Perform the upgrade offline.

« Perform the overall installation of the Storage Manager software into an existing
host environment online.

¢ For most failover drivers to take effect, restart the host.

* Make sure that all devices have an Optimal status before you download
firmware.

* Check the current firmware level to make sure that the firmware level is either
06.22.xx.xx or 06.24.xx.xx. The firmware upgrade tool supports upgrading to
07.xx level firmware from only firmware versions 06.22.xx.xx or 06.24.XX.XX.

Attention: To avoid a potential loss of data access, check the Storage Manager
readme file to make sure that the firmware you download is compatible with the
Storage Manager software that is installed on your storage subsystem. If
non-compatible firmware is downloaded, you might lose access to the drives in the
storage subsystem, so upgrade the Storage Manager software first. Do not make
changes to your configuration or remove drives or enclosures during the upgrade
process.

Checking the storage subsystem health conditions

To determine the health condition of the storage subsystem, complete the following

steps:

1. From the Array Management window in the Storage Manager software,
right-click the storage subsystem. The Storage Manager software establishes
communication with each managed device and determines the current status.
There are six possible status conditions:

Optimal
Every component in the storage subsystem is in the working condition
that you want.
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Needs Attention
A problem exists with the storage subsystem that requires intervention
to correct it.

Fixing A Needs Attention condition is corrected, and the storage subsystem is
currently changing to an Optimal status.

Unresponsive
The management station cannot communicate with one or both
controllers in the storage subsystem.

Contacting Device
The Storage Manager software is establishing contact with the storage
subsystem.

Needs Upgrade
The storage subsystem is running a level of firmware that is no longer
supported by the Storage Manager software.

If the status is Needs Attention, write down the condition. Contact your IBM
technical-support representative for fault resolution.

Note: The Recovery Guru in the Storage Manager software also provides a
detailed explanation of the conditions and recovery procedures.

Installing the controller firmware upgrade tool

To install the controller firmware upgrade tool, complete the following steps:

1.

ook wDd

Open the DS3000 Storage Manager 10 installation file according to your
operating system procedures. The IBM System Storage DS3000 Controller
Firmware Upgrade Tool is installed as part of the Storage Manager 10
installation.

Click Next.

Accept the license agreement, and click Next.

Select the folder in which you want to install the tool, and click Next.
Click Install.

Click Done.

Adding a storage subsystem

To add a storage subsystem using the upgrade tool, complete the following steps:

1.

2.
3.
4

Click Add. The Select Addition Method window opens.
Select either Automatic or Manual.
Click OK to begin adding storage subsystems.

To view any issues with the storage subsystem that you added that might
impede upgrading the firmware, click View Log.

Downloading the firmware

To download the firmware, complete the following steps:

1.

2.

Select the storage subsystem for which you want to download the firmware, and
then click Download Firmware. The Download Firmware window opens.

To choose the controller firmware file that you want to download from a directory
on your computer or on your network, click Browse.
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3. To choose the NVSRAM file that you want to download from a directory on your
computer or on your network, click Browse.

4. Click OK. The firmware starts to download. A status bar is displayed in the
Controller Firmware Upgrade window.

After the firmware file is downloaded, the firmware begins the activation process,
and the status Activating is displayed in the status bar in the controller firmware
upgrade tool.

Note: The firmware activation process can take up to 30 minutes to be completed.
If after 30 minutes the Activating status message is not changed, check the
controller profile data using the Storage Manager 10 software to determine if
the firmware download has completed successfully.

Viewing the controller firmware upgrade tool log file

If you encounter any problems updating the controller firmware, complete the
following steps to view the controller firmware upgrade tool log file:

1. Click View Log. The View Log window opens. This log documents any issues
with the storage subsystem that might prevent you from updating the firmware.

2. If any issues are documented in the log, correct those issues before you try to
download the firmware.
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Appendix C. Accessibility

This section provides information about alternative keyboard navigation, which is an
accessibility feature of the DS3000 Storage Manager software. Accessibility features
help a user who has a physical disability, such as restricted mobility or limited
vision, to use software products successfully.

By using the alternative keyboard operations that are described in this section, you
can use keys or key combinations to perform Storage Manager tasks and initiate
many menu actions that can also be done with a mouse.

In addition to the keyboard operations that are described in this section, the
DS3000 Storage Manager 2 software installation package for Windows includes a
screen reader software interface. To enable the screen reader, select Custom
Installation when you use the installation wizard to install the Storage Manager 2
software on a Windows host or management station. Then, in the Select Product
Features window, select Java Access Bridge in addition to the other required host
software components.

Keyboard focus is not always clearly shown in the panes of the help viewer window.
If you cannot see where the keyboard focus is, press Ctrl+F1. If the focus is on the
Back, Forward, Print, or Page Setup button in the toolbar, the alternative text for the
button is displayed. If alternative text is not displayed, keyboard focus is not on a
button. Press Ctrl+Tab to see whether the focus is on one of the navigator tabs
(Contents tab, Index tab, or Search tab). If the focus is on one of the navigation
tabs, press Shift+Tab to change the focus to the toolbar pane.

defines the keyboard operations that you can use to navigate, select, or
activate user interface components. The following terms are used in the table:

» Navigate means to move the input focus from one user interface component to
another.

» Select means to choose one or more components, typically for a subsequent
action.

* Activate means to carry out the action of a component.

In general, navigation among components requires the following keys:

» Tab: Moves keyboard focus to the next component or to the first member of the
next group of components

» Shift+Tab: Moves keyboard focus to the previous component or to the first
component in the previous group of components

» Arrow keys: Move keyboard focus among the components in a group of
components

Table 13. DS3000 Storage Manager software alternate keyboard operations

Shortcut Action
F1 Open the Help.
F10 Move keyboard focus to the main menu bar and posts

first menu; use the arrow keys to navigate through the
available options.

Alt+F4 Close the management window.

Alt+F6 Move keyboard focus among windows (non-modal) and
among management windows.
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Table 13. DS3000 Storage Manager software alternate keyboard operations (continued)

Shortcut

Action

Alt+underlined_letter

Access menu items, buttons, and other interface
components by using the keys that are associated with
the underlined letters.

For the menu options, press the Alt+underlined_letter to
access a main menu, and then press the underlined
letter to access the individual menu item.

For other interface components, press
Alt+underlined_letter.

Ctrl+F1 Display or conceal a tool tip when keyboard focus is on
the toolbar.
Spacebar Select an item or activate a hyperlink.

End, Page Down

Move keyboard focus to the last item in the list.

Esc

Close the current window (does not require keyboard
focus).

Home, Page Up

Move keyboard focus to the first item in the list.

Shift+Tab Move keyboard focus through components in the reverse
direction.

Ctrl+Tab Move keyboard focus from a table to the next user
interface component.

Tab Navigate keyboard focus among components or select a
hyperlink.

Down Arrow Move keyboard focus down one item in the list.

Left Arrow Move keyboard focus to the left.

Right Arrow Move keyboard focus to the right.

Up Arrow Move keyboard focus up one item in the list.
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Appendix D. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your system, and whom to call for service, if it is necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

» Check all cables to make sure that they are connected.

» Check the power switches to make sure that the system and any optional
devices are turned on.

» Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system. Information about diagnostic tools is
in the Problem Determination and Service Guide on the IBM Documentation CD
that comes with your system.

+ Go to the IBM support Web site at|http://www.ibm.com/systems/support/ to check
for technical information, hints, tips, and new device drivers or to submit a
request for information.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
documentation that is provided with your IBM product. The documentation that
comes with IBM systems also describes the diagnostic tests that you can perform.
Most systems, operating systems, and programs come with documentation that
contains troubleshooting procedures and explanations of error messages and error
codes. If you suspect a software problem, see the documentation for the operating
system or program.

Using the documentation

Information about your IBM system and preinstalled software, if any, or optional
device is available in the documentation that comes with the product. That
documentation can include printed documents, online documents, readme files, and
help files. See the troubleshooting information in your system documentation for
instructions for using the diagnostic programs. The troubleshooting information or
the diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to |http://www.ibm.com/systems/support/|and follow the
instructions. Also, some documents are available through the IBM Publications
Center at jhttp://www.ibm.com/shop/publications/order/}

Getting help and information from the World Wide Web

On the World Wide Web, the IBM Web site has up-to-date information about IBM
systems, optional devices, services, and support. The address for IBM System x™
and xSeries® information is |http:/www.ibm.com/systems/x/. The address for IBM
BladeCenter® information is |http://www.ibm.com/systems/bladecenter/ The address
for IBM IntelliStation® information is [http://www.ibm.com/intellistation/.
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You can find service information for IBM systems and optional devices at
Ihttp://www.ibm.com/systems/support/

Software service and support

Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with System x and xSeries servers,
BladeCenter products, IntelliStation workstations, and appliances. For information
about which products are supported by Support Line in your country or region, see
Ihttp://www.ibm.com/services/sl/products/

For more information about Support Line and other IBM services, see
Ihttp://www.ibm.com/services/, or see |http://www.ibm.com/planetwide/| for support
telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).

Hardware service and support

You can receive hardware service through your IBM reseller or IBM Services. To
locate a reseller authorized by IBM to provide warranty service, go to
lhttp://www.ibm.com/partnerworld] and click Find a Business Partner on the right
side of the page. For IBM support telephone numbers, see fhttp://www.ibm.com/|
In the U.S. and Canada, call 1-800-IBM-SERV (1-800-426-7378).

In the U.S. and Canada, hardware service and support is available 24 hours a day,
7 days a week. In the U.K., these services are available Monday through Friday,
from 9 a.m. to 6 p.m.

IBM Taiwan product service

598 IBM 72 A 55 T s 7 2
598 B PR e S e i D A IR
AL TR 7 5% 3

7E&% 1 0800-016-888

IBM Taiwan product service contact information:
IBM Taiwan Corporation
3F, No 7, Song Ren Rd.
Taipei, Taiwan
Telephone: 0800-016-888

114 DS3000 Storage Manager Installation and Support Guide for Windows, Linux, NetWare, and VMware


http://www.ibm.com/systems/support/
http://www.ibm.com/services/sl/products/
http://www.ibm.com/services
http://www.ibm.com/planetwide
http://www.ibm.com/partnerworld/
http://www.ibm.com/planetwide
http://www.ibm.com/planetwide

Appendix E. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. If these and other IBM trademarked terms are marked on their first
occurrence in this information with a trademark symbol (® or ™), these symbols
indicate U.S. registered or common law trademarks owned by IBM at the time this
information was published. Such trademarks may also be registered or common law
trademarks in other countries. A current list of IBM trademarks is available on the
Web at “Copyright and trademark information” at |ttp://www.ibm.com/legall
icopytrade.shtmil
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Adobe and PostScript are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States and/or other countries.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc., in the
United States, other countries, or both and is used under license therefrom.

Intel, Intel Xeon, Itanium, and Pentium are trademarks or registered trademarks of
Intel Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc., in
the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.

Important notes

When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity can vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives that are available from IBM.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven, including but not limited to the implied warranties of
merchantability and fitness for a particular purpose. These products are offered and
warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software might differ from its retail version (if available) and might not include
user manuals or all program functionality.
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